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1. Welcome to AUDIO KONTROL 1!
Thank you very much for choosing AUDIO KONTROL 1! Equipped with high end 
digital/analog converters, AUDIO KONTROL 1 combines versatile audio input 
and output slots that fit seamlessly into your setup. AUDIO KONTROL 1 also 
provides MIDI connection capacities as well as freely assignable controllers 
on the hardware’s top panel: It is the tactile interface to your software.

AUDIO KONTROL 1 provides two inputs and four outputs that allow you to use 
the hardware flexibly within a variety of setups. For instance, you can connect 
a microphone and record a voice, and at the same time you can record a guitar 
or trigger virtual instruments with your MIDI keyboard. Alternatively you can 
use AUDIO KONTROL 1 to listen to two completely independent stereo signals, 
a feature that is needed for DJ applications such as Traktor DJ Studio 3.

The NATIVE INSTRUMENTS software that is included with AUDIO KONTROL 
1 provides everything you need to start using your audio interface instantly. 
TRAKTOR 3 LE is a fully-featured digital DJ solution, the GUITAR COMBOS can 
be used immediately with your guitar or bass plugged into AUDIO KONTROL 
1’s instrument input and the XPRESS KEYBOARDS offer three outstanding 
synthesizers – all conveniently playable with your master keyboard.

Last but not least, AUDIO KONTROL 1 offers three buttons and a controller 
knob on the hardware’s top panel. You can assign any key command or 
MIDI message to actions performed with these elements. This turns AUDIO 
KONTROL 1 into a versatile controller that allows you to touch your software, 
be it one of the included applications, your favorite sequencer, your graphics 
software or other media applications such as Winamp or iTunes. Setup files 
for popular programs ensure the use of these features is hassle-free.

This manual will help you use all the features of AUDIO KONTROL 1. It is 
divided into three parts:

•	 Chapters 3 and 4: The first part explains how to setup your AUDIO 
KONTROL 1 quickly. It describes the different parts of the product 
and guides you through the installation process.

•	 Chapters 5 and 6: The second part illustrates different practical 
situations, from the simplest setup to more complex configurations. This 
learning-by-doing approach will familiarize you with AUDIO KONTROL 
1’s concept.

•	 Chapters 7 and 8: The third part gives you a detailed reference about 
the software interface and its operation. Reading this section will give 
you a full understanding of this great tool. It also contains a section 
about optimization and troubleshooting.
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2. Safety Considerations

Warning 

•	 Before using the AUDIO KONTROL 1 hardware, please read the manual 
and pay special attention to the instructions below. 

•	 The AUDIO KONTROL 1 hardware contains no user-serviceable parts. Do 
not open it or attempt to disassemble or modify any internal hardware. 
If there appears to be a hardware malfunction, immediately stop using 
the controller and have it inspected by qualified service personnel. 

•	 Do not expose the unit to rain, and do not use it near water or in damp 
or wet conditions. Also, never place anything on top of the controller, 
and be very careful that no objects or liquids of any kind enter the 
unit. 

•	 This product, in combination with an amplifier, headphones or speakers, 
can produce sound levels capable of damaging your ears. Do not use 
it for long periods of time at high volume levels. If you experience any 
hearing problems or ringing in the ears, consult a hearing specialist 
immediately.

•	 The AUDIO KONTROL 1 hardware is powered by the USB bus. Operation 
can be guaranteed only as a single device with a USB2 controller or 
with a self-powered USB2 hub. 

Caution 

•	 Before connecting the AUDIO KONTROL 1 hardware to other electronic 
components, turn off the power for all devices. Before powering your 
system up or down, set all volume levels to minimum. Gradually raise 
the volume controls while playing your instruments to set the desired 
listening level. 

•	 Do not place the AUDIO KONTROL 1 hardware in an unstable position 
where it might accidentally fall to the ground. 

•	 Before moving the AUDIO KONTROL 1 hardware, remove all connected 
cables. 
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•	 Never subject the unit to extreme temperatures (e.g., direct sunlight in an 
enclosed vehicle, or near a heat source), or high levels of vibration. 

•	 Do not use excessive force on the buttons, knobs, switches or 
connectors. 

•	 When cleaning the AUDIO KONTROL 1 hardware, use a soft, dry cloth. 
Do not use paint thinner, solvents, cleaning fluids, or chemically-
impregnated wiping cloths.

Important Notes  

•	 Disclaimer: Native Instruments GmbH cannot be held responsible for 
damage or data loss caused by improper use of, or modification to, 
the AUDIO KONTROL 1 hardware or software. It is your responsibility 
to back up data you don’t want to lose.

•	 Specifications subject to change: The information contained in this 
manual is believed to be correct at the time of printing. However, Native 
Instruments reserves the right to make changes to the specifications 
of software and hardware at any time without notice or obligation to 
update existing units. 

•	 Nameplate location: The nameplate is located on the bottom of the 
AUDIO KONTROL 1 hardware. It lists the product’s model name and 
other technical information. The serial number is also located on the 
bottom of the unit. 

•	 Disposal notice: Should this product become damaged beyond repair, or 
for some other reason come to the end of its useful life, please observe 
all regulations of your country that relate to the disposal of electronic 
products.  

•	 Copyright: © Native Instruments GmbH 2006. All rights reserved. This 
publication may not be reproduced in whole or in part, summarized, 
transmitted, transcribed, stored in a retrieval system, or translated into 
any language, in any form or by any means without the prior written 
permission of Native Instruments GmbH.

•	 All product and company names are trademarks or registered trademarks 
of their respective owners.



� – AUDIO KONTROL 1

3. Parts of the Product
In this section, we will quickly describe what is contained in the hardware 
and software sections of AUDIO KONTROL 1. Please take a moment to read 
this carefully; it will give you the basic knowledge of how AUDIO KONTROL 
1 works.

If you want to get started immediately, turn to section 4. There the setup of 
your AUDIO KONTROL 1 hardware and software is described in detail.

3.1. Hardware

3.1.1. Front Panel
The AUDIO KONTROL 1 front panel provides you with the connections and 
controls that you will probably modify the most. These include the audio inputs 
and their controls, the main outputs’ and monitor levels and the headphone 
output.

The AUDIO KONTROL 1 Front Panel.

1: Combo Input Jack (Input 1)

This analog audio input accommodates either XLR or phone plugs. The XLR 
plug (mono balanced) allows you to connect a microphone, routing the signal 
through the mic preamp. The phone plug (¼” jack, TRS mono balanced) 
allows you to connect a variety of other line level audio devices (mixer, MIDI 
sound module etc.).
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Please note that, depending on which plug you use (XLR or phone jack); you 
have to select the appropriate signal level on the Mic/Line Switch (2).

When using a condenser microphone, don’t forget to activate the Phantom 
Power Switch (18).

2: Input 1 Level Switch (Mic/Line)

This switch allows you to select the type of signal you have plugged into 
Input 1.

If you connect a microphone (using an XLR plug), activate the switch (pushed 
in). The incoming signal is then routed to the mic preamp, and its gain can 
be adjusted via the Mic Knob (3).

If you connect a line-level device (using a phone plug), deactivate the switch 
(pushed out). The incoming signal will then be routed to the line level circuitry 
and its gain can be adjusted via the Line Knob (6).

3: Microphone Input Sensitivity Knob (Mic)

This knob allows you to adjust the Input 1 gain if you connect a microphone 
(XLR plug). This knob controls the amplification level of the mic preamp.

If you connect a phone jack to Input 1, this knob will have no effect. The level 
of your signal can be adjusted via the Line Knob (6).

4: Input Jack (Input 2)

This analog audio input accepts phone plugs (¼” jack, TRS mono balanced). 
This input allows you to connect a variety of line-level audio devices (mixer, 
MIDI sound module, guitar etc.)

Please note that, depending on what kind of device you connect, you have to 
select the appropriate input impedance via the Inst/Line Switch (5).

5: Input Impedance Switch (Inst/Line)

This switch allows you to choose between high and low impedance for Input 
2, depending on what kind of device you have plugged into this input.

If you connect a mixer, a hardware sampler, a MIDI expander or any other 
line-level audio device, select the usual low impedance (Line: switch pushed 
out).

If you connect a guitar or bass (for use with GUITAR COMBOS for instance; 
see section 5.3), select high impedance (Inst: switch pushed in).

6: Line/Instrument Input Sensitivity Knob (Line)

This knob allows you to adjust the line/instrument input gain. This is relevant 
to the signal coming into Input 2, but not exclusively: on Input 1, if Line is 
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selected with the Mic/Line Switch (2) (and accordingly a phone jack is plugged 
into Input 1), this knob will control the level for the incoming signal of Input 
1 as well.

The knob also controls the gain of Input 2 if it is set to high impedance, i.e. 
if the Input Impedance Switch (5) is active.

To sum up: the Mic Knob (3) only deals with a microphone signal coming into 
Input 1, and the Line Knob deals with all other signals coming into Inputs 1 
and 2.

7, 8: Output Level Knobs (1/2 & 3/4)

These knobs adjust the output volume for each pair of Main Output Jacks on 
the rear panel (17).

9: Monitor On/Off Switch (On)

This switch turns the direct monitoring bus on/off. The direct monitoring 
bus allows you to listen directly to the input signals: the signal on this bus 
bypasses the AD and DA converters, the USB processor and the computer, 
so you can check what’s coming into the AUDIO KONTROL 1. The monitor 
signal is mixed with the computer output on one of the two output pairs (or 
both if desired). The selection of the output pair receiving the monitor signal 
is made within the driver settings (see section 7.2), and not on the AUDIO 
KONTROL 1 hardware.

10: Monitor Mono/Stereo Switch (Mono)

This switch, when activated (pushed in), merges the two inputs into one mono 
signal for monitoring. This can be useful, for example, if you’re using only one 
input on your AUDIO KONTROL 1: you can then monitor this input signal both 
on the left and right channels.

11: Monitor Level Knob

This knob adjusts the monitor volume when mixed with the computer’s main 
output signal. Turned hard left, you will only hear the signal coming from 
the computer, i.e. the monitoring signal is muted. Turned hard right, you will 
hear the input signal at its original level; the computer’s signal will preserve 
its level.

12: Headphone Output Selector Switch (1/2 – 3/4)

This switch allows you to choose which output pair (1/2 or 3/4) from the Main 
Output Jacks (17) is sent to the headphone output.
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13: Headphone Output Jack

This analog audio output accommodates a headphone jack (¼” jack, TRS 
stereo). Connecting headphones has no effect on the main outputs.

14: Headphone Output Level Knob

This knob adjusts the volume of the headphone output.

3.1.2. Rear Panel
The AUDIO KONTROL 1 rear panel is equipped with the connections that 
you won’t necessarily change for each new project. These include the main 
audio outputs, the MIDI input/output and the USB2 connection. It includes 
also the phantom power switch for the microphone input.

The AUDIO KONTROL 1 Rear Panel.

15: MIDI In/Out Connectors

These connectors allow you to connect MIDI devices to your computer and to 
send/receive MIDI messages.

16: USB2 Connector

Use this connector to connect the AUDIO KONTROL 1 to your computer.

17: Main Outputs Jacks (1 to 4)

These analog audio outputs accept phone plugs (¼” jack, TRS mono balanced). 
You can use them to send the output signals to an amplification system or 
other mix down device (desk, effects…)
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18: Phantom Power Switch (48V)

This switch has to be activated (pushed in) if you are using a microphone on Input 
1 that requires a phantom power supply (e.g. a condenser microphone).

3.1.3. Top Panel
Whereas the front and rear panel deal with audio and MIDI signals, the AUDIO 
KONTROL 1 top panel is dedicated to the manual controls. It provides you 
with a set of four Controllers which act like a remote control for your computer 
applications. These Controllers are of two types: the Controller Knob and the 
Left, Middle and Right Buttons.

The top panel also provides a number of LEDs for monitoring the various 
activities of the box.

The AUDIO KONTROL 1 Top Panel.
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19: Controller Knob, 20: Left Button, 21: Middle Button, 22: Right Button

The use of these four Controllers will be extensively explained in the next 
sections. They are the core of the remote control of AUDIO KONTROL 1.

23, 24: Info LEDs

These LEDs inform you about various aspects of AUDIO KONTROL 1.

•	 48V: indicates the state of the Phantom Power Switch (18).

•	 Input 1: indicates activity at the hardware’s first audio input. It lights 
red if the signal is clipped. In this case you should decrease the Input 
1 level.

•	 Input 2: indicates activity at the hardware’s second audio input. It lights 
red if the signal is clipped. In this case you should decrease the Input 
2 level.

•	 Output 1/2: indicates activity at the hardware’s first audio output pair 
(Main Output Jacks 1/2, 17).

•	 Output 2: indicates activity at the hardware’s second audio output pair 
(Main Output Jacks 3/4, 17).

•	 USB: indicates the USB connection state. If the connection is established 
it is steadily lit. It blinks while the components are initializing.

•	 MIDI In: indicates if there are MIDI messages being received at the 
hardware’s MIDI Input (15).

•	 MIDI Out: indicates if there are MIDI messages being sent from the 
hardware’s MIDI Output (15).

•	 Monitor 1/2: indicates if the direct monitoring signal is being sent to 
the first audio output pair (Main Output Jacks 1/2, (17)).

•	 Monitor 3/4: indicates if the direct monitoring signal is being sent to 
the second audio output pair (Main Output Jacks 3/4, (17)).

3.2. Software
The software section of AUDIO KONTROL 1 is divided into two programs:

•	 The Driver, which handles communication between the AUDIO KONTROL 
1 hardware and your computer.

•	 The Mapping Application, which waits for events at the hardware’s top 
panel elements, reported by the driver, and maps them to software 
actions.



14 – AUDIO KONTROL 1

3.2.1. Driver
The driver basically acts like any other driver supporting a device connected to 
your computer. It is an interface between your computer and the real world (in 
our case, the AUDIO KONTROL 1 hardware). The AUDIO KONTROL 1 driver 
handles different types of signals: audio signals are routed to your computer’s 
corresponding audio driver (ASIO, Core Audio…), MIDI signals are routed to 
your music applications, and interactions at the hardware’s top panel (also 
called “hardware events”) are sent to the Mapping Application.

Some of the driver parameters can be edited via the Driver Control Panel. Please 
refer to section 7.2 for more info on how to edit the driver’s parameters.

3.2.2. Mapping Application
AUDIO KONTROL 1 lets you control your music applications (or, in fact, any 
other application) from the four Controllers on the hardware top panel. These 
Controllers are assigned to specific commands in your target application (for 
example a keyboard shortcut or a MIDI message).

The Mapping Application controls the mapping system, which handles the 
interactions with the four Controllers: the Controller Knob and the Left, Middle 
and Right Buttons. The mapping system defines the connections between 
hardware and software interactions.

Let’s look at a quick example to understand the remote control signal flow 
in AUDIO KONTROL 1. When you turn the Controller Knob on the AUDIO 
KONTROL 1 top panel, the device sends an event through the USB2 connection 
to your computer. The driver receives this event, translates it and sends it to 
the Mapping Application. The Mapping Application then executes the software 
action corresponding to this event, for instance turning Winamp’s volume up 
or down.

Each Button has a special mode called Modifier. In this mode, the Button 
plays the role of a “Shift” or “Ctrl” key: it does not carry out a specific action 
in the target software, but instead, when pressed, it modifies the action of the 
three other Controllers (the Controller Knob and the two other Buttons) in the 
target software. That way, it is possible to define different assignments for the 
same Controller, depending if another Button, set as modifier, is pressed or 
not. This creates different “Layers” in the mapping system: one Main Layer 
when no modifier is pressed, and three additional Layers, one for each Button 
(if it is set as a modifier). You will get more info on this in section 7.3.
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The Mapping Application (Display View).

The mapping system is fully customizable: with the Mapping Application, you 
can assign a wealth of actions to each Controller and even to combinations of 
them, thus deciding what has to be done in your music application, whatever 
you do on the hardware top panel.

A full set of assignments for the four Controllers is called a Page. The Mapping 
Application comes with many prepared Pages. These Pages are meant for the 
most common uses of the Controllers with NATIVE INSTRUMENTS products, 
major sequencers and other audio applications. You can then customize these 
Pages and create your own Pages from scratch to fit your needs.

For more info on customizing the Mapping Application, please refer to section 
7.4. You will also find examples of using the Mapping Application in sections 
5 and 6.
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4. Setup

4.1. Hardware
This section quickly describes in a pictorial way some possible uses of AUDIO 
KONTROL 1 in various setups. We give here only general guidelines, the 
details to these situations can be found in the sections 5 and 6. Please also 
note that you can find detailed information about each part of the hardware 
within section 3.1 above.

In all setups, please use balanced cables as the audio inputs and outputs of 
your AUDIO KONTROL 1 hardware are balanced, too.

Do not connect the AUDIO KONTROL 1 hardware to your computer until 
you have finished the software installation and driver setup (see below, 
section 4.2). The driver installer will ask you to connect the Controller 
at the proper time.
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4.1.1. Setup 1: Keyboard/Studio

KEYBOARD / STUDIO

DJ - INTERNAL MIXER

1/2-3/4 Switch
set to 1/2

GUITAR

RECORDING ROOM HEADPHONE AMPLIFIER

CONTROL ROOM

Line/Mic Switch set to Mic

1/2-3/4
Switch

set to 1/2

Line/Inst
Switch
set to Inst

Line/Mic
Switch

set to Mic

DJ - EXTERNAL MIXER

LI
NE

 1
 R

LI
NE

 1
 L

LI
NE

 2
 R

LI
NE

 2
 L

This setup shows you how to use AUDIO KONTROL 1 in a studio configuration. 
This features:

•	 All what is needed to record a voice, i.e. a microphone is used with Input 
1, and there are two different signals for the control room (headphones, 
active speakers) and the recording room (headphones). 

•	 A small MIDI setup, i.e. master keyboard is connected to the MIDI In 
port of AUDIO KONTROL 1.

This setup serves as a basis for the Use Case of section 6.1, where it is 
explained in detail.
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4.1.2. Setup 2: DJing (Internal Mixer)

KEYBOARD / STUDIO

DJ - INTERNAL MIXER

1/2-3/4 Switch
set to 1/2

GUITAR

RECORDING ROOM HEADPHONE AMPLIFIER

CONTROL ROOM

Line/Mic Switch set to Mic

1/2-3/4
Switch

set to 1/2

Line/Inst
Switch
set to Inst

Line/Mic
Switch

set to Mic

DJ - EXTERNAL MIXER

LI
NE

 1
 R

LI
NE

 1
 L

LI
NE

 2
 R

LI
NE

 2
 L

This setup can be used with the included NATIVE INSTRUMENTS product 
TRAKTOR 3 LE. It allows you to execute sophisticated mixes using only a 
computer, AUDIO KONTROL 1, a headphone and an amplification system. 
This setup is used in the Quickstart of section 5.2 where you will find detailed 
information.
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4.1.3. Setup 3: DJing (External Mixer)

KEYBOARD / STUDIO

DJ - INTERNAL MIXER

1/2-3/4 Switch
set to 1/2

GUITAR

RECORDING ROOM HEADPHONE AMPLIFIER

CONTROL ROOM

Line/Mic Switch set to Mic

1/2-3/4
Switch

set to 1/2

Line/Inst
Switch
set to Inst

Line/Mic
Switch

set to Mic

DJ - EXTERNAL MIXER

LI
NE

 1
 R

LI
NE

 1
 L

LI
NE

 2
 R

LI
NE

 2
 L

If you prefer to use your hardware mixer for DJing with your computer, this setup 
is for you. All connections between your mixer and other gear (headphones, 
amplification system…) are those of a standard DJ setup. The only difference is 
that your mixer gets its inputs from AUDIO KONTROL 1 instead of turntables. 
TRAKTOR 3 LE can also handle this setup. Please refer to the separate manual 
of TRAKTOR 3 LE for detailed information. 
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4.1.4. Setup 4: Guitar/Bass

KEYBOARD / STUDIO

DJ - INTERNAL MIXER

1/2-3/4 Switch
set to 1/2

GUITAR

RECORDING ROOM HEADPHONE AMPLIFIER

CONTROL ROOM

Line/Mic Switch set to Mic

1/2-3/4
Switch

set to 1/2

Line/Inst
Switch
set to Inst

Line/Mic
Switch

set to Mic

DJ - EXTERNAL MIXER

LI
NE

 1
 R

LI
NE

 1
 L

LI
NE

 2
 R

LI
NE

 2
 L

The AUDIO KONTROL 1 software bundle includes the great GUITAR COMBOS, 
putting a bunch of outstanding guitar combos into your computer. This setup 
shows you how to play them from your electric guitar. You can use a microphone 
at the same time. Therefore, the instrument is connected to Input 2 with 
the Line/Inst Switch set to Inst, and the microphone is connected to Input 
1, setting the Mic/Line switch to Mic. This setup is explained in detail in the 
Quickstart of section 5.3.

4.2. AUDIO KONTROL 1 Software Installation
AUDIO KONTROL 1 is a tightly integrated system of software and hardware: 
Before using AUDIO KONTROL 1, the product’s software must be 
installed, particularly the driver. You might also want to install the bundled 
software applications XPRESS KEYBOARDS, TRAKTOR 3 LE and GUITAR 
COMBOS.

Do not connect the AUDIO KONTROL 1 hardware to your computer 
until you have finished the software installation and driver setup (see 
below). The driver installer will ask you to connect the Controller at the 
proper time.
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To start the installation, insert the AUDIO KONTROL 1 CD into the optical 
drive. Open the Windows Explorer (the Finder on the Mac) and double-click the 
CD to see the files on the CD-ROM. Start the installation by double-clicking 
“AUDIO KONTROL 1 Setup” (by launching “AUDIO KONTROL 1 Installer” 
on Mac OS X).

This will start the installation program. It will ask which parts of the AUDIO 
KONTROL 1 software you want to install:

•	 AUDIO KONTROL 1 Driver

•	 AUDIO KONTROL 1 Mapping Application

•	 Service Center

Make sure that you install the AUDIO KONTROL 1 Driver and the AUDIO 
KONTROL 1 Mapping Application when you install the product on your 
machine for the first time. Without them, AUDIO KONTROL 1 will not 
work correctly.

If you choose to install only a selection of the possible packages, you can start 
the installer again at some other time to add the missing packages conveniently. 
Don‘t install one of the packages a second time if it is already present on your 
system: This might cause problems with your computer system‘s setup.

The NI Service Center is required to activate those products via the 
internet. You can find detailed information about activation in the separate 
Setup Guide, placed within the Start menu entry of the Service Center (in 
the Service Center’s application folder on Mac OS X) after installation. 
If you already installed the Service Center as part of another product 
by Native Instruments, a second installation is not necessary.

After you confirmed your selection of packages by going to the next page of 
the installer, the software is being installed. This is done by several smaller 
installers that are triggered by the main setup program. During the installation 
you will be asked a series of questions regarding where certain components 
of the program should be placed. In most cases you can simply accept the 
default choices for each of these (unless you have some reason for changing 
them). 



22 – AUDIO KONTROL 1

The installation process of the AUDIO KONTROL 1 Driver will ask you to 
connect your hardware at some point. Please follow the given instructions 
closely. However, the installer will also ask you to restart the computer 
when the installation is finished to make the settings become effective. 
Don’t do this until all installation processes you selected have been 
finished completely!

After the installation of all selected packages is completed and the computer 
has been re-booted you can start using AUDIO KONTROL 1 by connecting it to 
your audio environment. However, there are five steps that are recommended 
to do before you begin to make music:

•	 Continue reading this manual. It explains how you can benefit from all 
features of AUDIO KONTROL 1.

•	 Check the settings of the AUDIO KONTROL 1 Driver. The detailed 
description of the Driver Control Panel can be found in section 7.2. 
Once the driver is installed, you can access the settings as follows:

•	 Within the Mapping Application, click on the Driver Button at the top 
right of the window.

•	 From the Mac OS X operating system, adjust the audio settings within 
the Mac’s System Preferences.

•	 From the Windows operating system, use the “Control Panel” link 
within the Start menu created during the driver installation.

•	 Configure the bundled software by Native Instruments to use AUDIO 
KONTROL 1 as audio and MIDI interface. This is described in the 
separate Setup Guide installed with the Service Center. You can also 
refer to the quickstarts of this manual (found in section 5) for a fast 
approach.

•	 Configure any third-party software you intend to use with AUDIO 
KONTROL 1, e.g. your operating system, your sequencer, or programs 
like Winamp and iTunes. Refer to the documentation of that software 
for detailed information on how to set it up correctly. The following 
section will also give you a fast introduction.

Important: You can install the additional software bundle by using the 
seperate installers on the installation disc.
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4.3. Configuring Third-Party Software

4.3.1. The MIDI ports of AUDIO KONTROL 1
AUDIO KONTROL 1 contains one MIDI input port and one MIDI output port 
on the hardware side. However, when you configure your software applications 
to interact with the AUDIO KONTROL 1 hardware, you will note that the driver 
offers a second MIDI input/output pair.

The first MIDI pair can be used to access the hardware ports. Activate them 
if you want to control your software with external MIDI gear (e.g. a master 
keyboard) or if you want to send MIDI messages to any other hardware.

The second pair is obviously not present at the hardware. Instead, it is used by 
the Mapping Application to send MIDI messages to your applications. Only if 
your application uses this second pair of MIDI ports, the Mapping Application 
will be able to control it via MIDI.

Of course, you can combine both ports, i.e. your application can use the 
external MIDI input and the virtual input at the same time.

4.3.2. Using AUDIO KONTROL 1 as the default audio interface in Windows XP
To use AUDIO KONTROL 1 as your default audio interface under Windows 
XP, do the following:

•	 Open Start > Control Panel > Sounds and Audio Devices.

•	 Click the Audio tab.

•	 In the Sound playback, Sound recording and MIDI music playback 
sections, click the Default device menu and select AUDIO KONTROL 
1 Out 1, AUDIO KONTROL 1 In 1 and AUDIO KONTROL 1 MIDI Out 
1 respectively.

•	 Click OK to close the Sounds and Audio Devices dialog.

4.3.3. Using AUDIO KONTROL 1 as the default audio interface in Mac OS X
To use AUDIO KONTROL 1 as your default audio interface under Mac OS X, 
do the following:

•	 From the Apple menu, select System Preferences, and in the panel 
that opens, click Sound.

•	 Click the Sound Effects tab and choose AUDIO KONTROL 1 in the Play 
alerts and sound effects through menu.

•	 Click the Output tab, and choose AUDIO KONTROL 1 in the Choose a 
device for sound output list.
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•	 Click the Input tab, and choose AUDIO KONTROL 1 in the Choose a 
device for sound input list.

4.3.4. Configuring Cubase with AUDIO KONTROL 1 (ASIO)
To configure Cubase SX/SL with AUDIO KONTROL 1, do the following:

•	 From the Devices menu, select Device Setup. The Device Setup dialog 
pops up.

•	 In the Devices list, on the left, click VST Audiobay.

•	 Select the AUDIO KONTROL 1 driver from the Master ASIO Driver 
menu.

The procedure is similar in all applications that use ASIO to connect to your 
audio interface. For detailed explanations, please refer to the respective 
operation manual.

4.3.5. Configuring Logic with AUDIO KONTROL 1 (CoreAudio)
To configure Logic 7 Pro with AUDIO KONTROL 1, do the following:

•	 From the Audio menu, select Audio Hardware & Drivers. The Preferences 
dialog automatically shows the Audio/Drivers/CoreAudio tab.

•	 Select the AUDIO KONTROL 1 driver from the Driver menu.

The procedure is similar in all applications that use CoreAudio to connect to 
your audio interface. For detailed explanations, please refer to the respective 
operation manual.
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5. Quickstarts
In this section, we will assume that you already have AUDIO KONTROL 1 set-
up and running successfully. That notably means that the Mapping Application 
has already started up, as it should be automatically loaded when the system 
starts. If this is not the case, please refer to section 4.2 for more information. 
You should also have already installed the software bundle included in AUDIO 
KONTROL 1. Once again, if not, please refer to section 4.2.

We also assume that you have already carefully read section 3.1, which 
describes and explains every socket and control found on the AUDIO KONTROL 
1 hardware.

We will present here four different scenarios that demonstrate what AUDIO 
KONTROL 1 can do. These situations represent small setups, allowing you 
to get to work quickly, and will teach you the basics of working with AUDIO 
KONTROL 1. The first three scenarios make use of the great products included 
in the AUDIO KONTROL 1 package, so you don’t need any third-party music 
software. Within a few steps, you will be able to start making noise!

For more complex setups and advanced uses of AUDIO KONTROL 1, please 
read the following section 6.

5.1. Playing XPRESS KEYBOARDS from a MIDI keyboard
The first scenario is quite simple. It only deals with playing a software 
instrument from a MIDI keyboard and listening to the result on your PA. This 
task is maybe one of the most common in the computer musician’s world, 
and we will show here how to do it right away via the AUDIO KONTROL 1 
audio interface and one of the included products by NATIVE INSTRUMENTS. 
If you’re already used to doing this, you can go directly to the next scenario. 
But it’s always worth reading it: it will help you in getting more and more 
familiar with AUDIO KONTROL 1.

We have to do two things: first, we’re going to set up the incoming MIDI signal 
flow; then, we’re going to set up the outgoing audio signal flow.

5.1.1. MIDI Connections
Let’s first connect your MIDI keyboard to AUDIO KONTROL 1. Connect the 
MIDI output of your MIDI master keyboard into the AUDIO KONTROL 1 MIDI 
In Connector. When you press a key on your master keyboard, you should see 
the LED light up on the AUDIO KONTROL 1 hardware top panel, following 
your actions on the keyboard.
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We now have to choose our instrument. AUDIO KONTROL 1 comes with 
NATIVE INSTRUMENTS’ XPRESS KEYBOARDS software bundle. This bundle 
includes the XPRESS version of three software instruments from NATIVE 
INSTRUMENTS: B4, PRO-53, and FM7. These XPRESS versions combine the 
outstanding sound of the full versions with an incredible ease-of-use. Each 
of them is equipped with a factory soundbank offering you the most popular 
sounds of their predecessors.

AUDIO KONTROL 1 includes the XPRESS KEYBOARDS software bundle, offering you three great 
sounding and easy-to-use software instruments.

Let’s choose the PRO-53. First, launch it, and go to the menu File > Setup. 
Here, click on the MIDI Tab. We want to be sure that the PRO-53  receives 
the MIDI message from your AUDIO KONTROL 1 MIDI interface. In the upper 
table, you will see a list of your MIDI Input interfaces. Verify that both entries 
of the “AUDIO KONTROL 1” are set to On. If one or both of them are set to 
Off, click on this Off icon to activate the input (the Off will turn to On). Then 
click OK to save your settings. The PRO-53 is now ready to receive the MIDI 
messages that your master keyboard will send through AUDIO KONTROL 1. 
(Additionally, the second MIDI port will pass all messages generated with the 
AUDIO KONTROL Mapping Application to the PRO-53. This, however, will 
not be used within this first quickstart.)

To check this, press a key on your master keyboard: the PRO-53 MIDI Indicator 
(on the left of the virtual keyboard) should turn red, both when you press the 
key and when you release it. You should see also the corresponding key being 
pressed on the virtual keyboard:
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For more information on the settings in PRO-53 XPRESS, please refer to the 
PRO-53 manual, included in PDF format in the installation folder.

5.1.2. Audio Connections
Now that the MIDI section is done, let’s look at the audio section.

Like any software instrument, PRO-53 generates its sound via its virtual 
outputs. We have to assign these virtual outputs to the AUDIO KONTROL 1 
outputs.

To do so, go back to the menu File > Setup, and click on the Soundcard Tab. 
There, choose “ASIO AUDIO KONTROL 1” in the Output Device menu. Then 
click on the Routing Tab. Here, you can select to which physical connector of 
your audio interface the signals have to be routed (both input and output). 
We are interested here in the output signal, so click on the Output Tab. You 
can then choose, in the two menus Master Left and Master Right, the physical 
output you want to use for each of them. Let’s choose “AUDIO KONTROL 
1 Out 1” and “AUDIO KONTROL 1 Out 2”. They correspond to the first two 
Main Output Jacks on the rear panel of your AUDIO KONTROL 1 hardware. 
Then click OK to save your settings. The PRO-53 XPRESS will now send its 
sound to your AUDIO KONTROL 1 Main Outputs Jacks 1 and 2.

Once again, for more information on the settings in PRO-53 XPRESS and all 
other products included with AUDIO KONTROL 1, don’t hesitate to dig into 
the manual of each product. All manuals are included in PDF format with 
the installers.

If you haven’t already done so, you still have to connect audio cables between 
those outputs and your amplification system. Be sure to use balanced cables, 
as the outputs of AUDIO KONTROL 1 require this type of connection.
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Important: Be careful! Before doing so, turn all volume levels down to 
avoid any clicks that might damage your speakers and/or your ears! On 
your AUDIO KONTROL 1 hardware, turn the Output Level Knob (1/2 or 
3/4, depending on which outputs you selected in PRO-53) all the way 
down. Do the same with the volume on your amplifier. Then, and only 
then, plug the audio cables between the selected outputs and your 
amplifier inputs, and you can turn the volume levels back up again.

When you now play on your master keyboard, you will hear the sound of the 
PRO-53.

That is the simplest use of AUDIO KONTROL 1, using only its audio/MIDI 
interface. In the next scenario, we will make use of its particularly outstanding 
function: the remote control.

5.2. Controlling TRAKTOR 3 LE
This second scenario will show you how to quickly start DJing via AUDIO 
KONTROL 1 and TRAKTOR 3 LE, NATIVE INSTRUMENTS’ award-winning 
DJ software, included with AUDIO KONTROL 1. TRAKTOR 3 LE allows you 
to mix tracks stored on your computer, via virtual decks equipped with the 
most advanced mixing features. TRAKTOR 3 LE also includes an internal 
mixer with outstanding effects and a powerful track browser to manage your 
music collection. For an in-depth presentation of TRAKTOR 3 LE, please 
refer to the corresponding operation manual located in the TRAKTOR 3 LE 
installation folder.

We will make use here of AUDIO KONTROL 1’s remote control capabilities 
to take control of TRAKTOR 3 LE. We will also use the AUDIO KONTROL 1 
audio interface to bring everything to the dance floor – and to your ears.

Although TRAKTOR 3 LE can also be used with an external hardware mixer, 
here we will use its internal mixer, giving us access, among other things, to 
its great effects. The scenario described here is actually the one depicted in 
section 4.1.2. Please refer to the picture in this section for an overview of 
the audio section of our setup.

5.2.1. Audio Connections
The most important thing in DJing is the ability for the DJ to listen to something 
else than the music sent to the audience: When a track is playing on the dance 
floor, the DJ is already working on the next track to be played. This is called 
“cue listening”. Of course, TRAKTOR 3 LE handles this in various ways. Here 
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we will build a setup including a main stereo output for the audience (and DJ 
booth if needed), and a second stereo output for cue listening. Your AUDIO 
KONTROL 1 hardware is, by the way, equipped with four outputs, i.e. two 
stereo outputs. Perfect! Let’s wire it all up.

Physical Connections

Connect the Main Output Jacks 1 and 2 on the hardware’s rear panel to your 
power amplification system. Your main mix will come out of the box through 
those sockets.

Important: As we said in the previous quickstart, be careful when doing 
so, and turn all relevant volume levels down before plugging anything 
into anything! Your ears will thank you later.

For the cue listening output, we will use the two other outputs of AUDIO 
KONTROL 1. But actually we won’t plug anything into Main Output Jacks 3 
and 4. Instead, we want (and we’re not the only ones) to use the headphones 
to work on the next track. So plug your headphones into the Headphone Output 
Jack on the hardware’s front panel. Next to the Headphone Output Jack, set 
the Headphone Output Selector Switch to position “3/4” (switch engaged), so 
that you hear outputs 3 and 4 in your headphones.

Configuring TRAKTOR 3 LE

Now that the hardware section is ready, let’s configure TRAKTOR 3 LE 
accordingly. Launch TRAKTOR 3 LE and click on the Preferences Button on 
the top right of the window. This brings up the Preferences window. In the 
left pane, unfold the “Audio Setup” category by clicking on the little “+” on 
its left.

Click on the first entry, “Soundcard”, and check that “Audio Kontrol 1” is 
selected as audio device.

Now click on the second entry, Output Routing. Here, you can choose where to 
send each of TRAKTOR 3 LE’s outputs. In the first line, Mixer Mode, select 
Internal Mixer, since we want to use TRAKTOR 3 LE’s mixer. The following 
line, Monitor, allows you to choose a routing for TRAKTOR 3 LE’s headphone 
output. In the dropdown menu, select “AUDIO KONTROL 1 Out 3” and 
“AUDIO KONTROL 1 Out 4” for the left and right channels. If you wish, you 
can activate the Mono Button to mix both left and right channels together in 
your headphones. The third line, Master, deals with the main output. Here, 
select “AUDIO KONTROL 1 Out 1” and “AUDIO KONTROL 1 Out 2”, as we 
decided to do earlier. The Output Routings should now look like this:
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The TRAKTOR 3 LE Preferences window, for use with the internal mixer and AUDIO KONTROL 1.

Within a later step of this quickstart, we will use the Mapping Application to 
remotely control TRAKTOR 3 LE. Therefore, TRAKTOR 3 LE needs to listen to 
the MIDI messages coming from the Mapping Application: Unfold the “Hotkey 
& MIDI Setup” category and click on the entry “MIDI Interfaces” and activate 
both input ports of the AUDIO KONTROL 1 hardware.

We don’t need here to change any other settings in TRAKTOR 3 LE. For more 
info about the other settings, please refer to the TRAKTOR 3 LE operation 
manual located in the TRAKTOR 3 LE installation folder.

Let’s check the audio setup by starting the playback on a deck.

Load a track on Deck A by dragging and dropping from the Track List, click 
on the Play Button and check that the Crossfader is set hard left.

Turn the Ph Mix Knob on the TRAKTOR 3 LE Mixer hard left, so that only the 
Cue signal is sent to the Monitor output (your headphones).

If the Cue Button for Deck A’s channel is deactivated in the Mixer, the sound 
will be sent through TRAKTOR 3 LE’s Master Output to AUDIO KONTROL 
1’s Main Output Jacks 1 and 2, and finally to your amplification system, and 
you will hear the sound on the dance floor (or in your room). If you don’t hear 
anything, check on your AUDIO KONTROL 1 hardware that the Output Level 
Knob 1/2 is no longer at zero.
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If you activate the Cue Button (by clicking it), the sound will be sent through 
TRAKTOR 3 LE’s Monitor Output to AUDIO KONTROL 1’s Main Output Jacks 3 
and 4. Those jacks are not wired, but AUDIO KONTROL 1’s headphone output 
receives these outputs (thanks to the Headphone Output Selector Switch), and 
you will hear the music in your headphones. Once again, if you don’t hear 
anything, check on your AUDIO KONTROL 1 hardware that the Headphone 
Output Level Knob is not at zero.

That’s it; we’re done with the audio setup.

Note: If you wish to check in your headphones what is sent to the 
audience, you now have the option. You can do it on the software side by 
adjusting the Ph Mix Knob in TRAKTOR 3 LE (you then have a continuous 
crossfade between the Cue signal and the Master signal). But you can 
also do it quickly on the hardware side by playing with the Headphone 
Output Selector Switch on the AUDIO KONTROL 1 hardware’s front 
panel: With the switch engaged, you can hear the Cue signal (i.e. the 
outputs 3/4), and with the switch disengaged, you can hear the Master 
signal (outputs 1/2).

(Actually, as if that wasn’t enough, you can even do it through the Controller 
Knob by assigning it to the Ph Mix Knob. After having read this manual, you 
will able to do it within seconds.)

5.2.2. Controlling TRAKTOR 3 LE
We will now look at the most innovative part of AUDIO KONTROL 1: its Remote 
Control. Located on the hardware’s top panel, its behavior is managed by the 
Mapping Application. The mapping system for the hardware’s four top panel 
Controllers is organized into the so-called Controller Pages. A single Controller 
Page is a full set of assignments for the four Controllers in the four Layers. If 
this sounds new to you, we recommend you to read the relevant subsections 
in section 2. The concept of Layers is extensively described in section 7.3.

AUDIO KONTROL 1 comes with plenty of Factory Pages for many applications, 
and there is also one for TRAKTOR 3 LE. We will use such a Page here, to 
concentrate on the use of the hardware top panel. Later, we will explain how 
to program custom User Pages so you can create your own assignments to 
fit your needs.

Let’s begin. First, brings the Mapping Application to the front in your operating 
system. This can be done by double-clicking the application’s icon within the 
system tray of Windows XP (the Status Bar on Mac OS X). If you cannot find it 
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there, the application is not running. In this case, start it from the Start menu 
(or the application’s folder on Mac OS X). In the top line, called the Application 
Control Bar, the first Button is marked either „Assign” or “Display”. If you see 
“Display”, click on it to switch to the Display View. If you see “Assign”, then 
leave it, as you are already where we need to be: in the Display View.

On the right, we see a menu, called the Page Select menu. Its name is clear 
enough, and we will click on it to select the appropriate Controller Page to 
control TRAKTOR 3 LE. Select the entry “TRAKTOR 3 LE”. The Mapping 
Application then loads this Page and you will see all of its assignments in the 
rest of the window.

The Mapping Application with the TRAKTOR 3 LE Page loaded.

The lower part of the window, called the Hardware Area, represents the 
hardware’s top panel. When you move your mouse above one of the displayed 
Controllers, the upper part of the window, called the Information Area, displays 
the assignments for that Controller.

Now let’s take control of TRAKTOR 3 LE. To see what’s happening, bring 
TRAKTOR 3 LE to the front. Move the Controller Knob on your hardware: 
the Master Knob in the Mixer instantaneously follows the Controller Knob 
movements, adjusting the overall output volume of your mix.

If you press any of the three Buttons, nothing happens: they are all set to the 
Modifier mode, meaning that they don’t have a specific action, but instead 
they modify the action of each Controller.
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For example, press and hold the Left Button. You are now controlling Deck A. 
The Controller Knob doesn’t control the Master Volume anymore, but instead 
it drives the Fine Pitch parameter for that Deck. This parameter is not actually 
displayed on the TRAKTOR 3 LE interface; it can only be controlled via MIDI 
- and now via AUDIO KONTROL 1. Like it says, this parameter is a fine pitch 
adjustment, much more precise than the Tempo Knob that you see on each 
Deck.

With the Left Button still held down, the Middle and Right Buttons are the Play 
and Cue Buttons for Deck A, respectively. There’s no need to grab the mouse 
to start, stop and cue the playback anymore, you just have to press and hold 
the Left Button, and then play with the two other Buttons. Easy, isn’t it? That’s 
exactly what AUDIO KONTROL 1’s Remote Control is about.

Now that you’ve finished with the Left Button, release it and press and hold 
the Right Button. You now have access to exactly the same features, but for 
Deck B. Fine Pitch, Play and Cue for Deck B are on your hardware’s top panel, 
right at your fingertips.

We’ve played up to now with the Main Layer (no Button pressed and held), and 
the Left and Right Layers (Left or Right Button pressed and held, respectively). 
The last Layer, the Middle Layer, is logically activated by pressing the Middle 
Button. You then have access to the following parameters: the Controller Knob 
controls the Crossfader, and the Left and Right Buttons control the first and 
second buttons of the Master Effect currently loaded in TRAKTOR 3 LE.

With four Controllers on your hardware’s top panel, you have thus control 
over 10 parameters in your software. Load another Factory Page dedicated 
to TRAKTOR 3 LE, or create a custom User Page, and you’ll get another 10 
parameters on your AUDIO KONTROL 1 hardware top panel.

You will learn how to program your own Controller Pages in sections 6.2 and 
6.3, and you can find all info about it in section 7.4.4.

5.3. Playing a Guitar Riff with GUITAR COMBOS
We will now look at another application, this time making use of AUDIO 
KONTROL 1’s audio input capabilities. For this purpose, we will move to 
another musical world: the electric guitar & bass empire. Following the multi-
functional high-end ready-to-use concept driving AUDIO KONTROL 1, we 
included another great piece of software in the box: GUITAR COMBOS. This 
set of three outstanding tube amplifier emulations uses the same critically 
acclaimed technology that has already won NATIVE INSTRUMENTS’ GUITAR 
RIG 16 industry awards, and covers a huge range of musical styles within the 
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simplest and easiest-to-use interface. It looks just like the real thing, you use 
it just like the real thing, and it sounds just like the real thing.

GUITAR COMBOS and its three high quality tube combo emulations.

The advantages of such a setup compared with a guitar directly plugged 
into an amp are numerous: among them, you have here not one, but three 
amps, modeled from such which would actually cost a considerable amount 
of money if you wanted to have them all in your rehearsal room or on stage. 
Additionally, with all of them now on your computer, it’s really easy to take 
them with you. Moreover, AUDIO KONTROL 1’s Remote Control allows you to 
tweak them from its hardware top panel, giving you a physical, analog-like, 
real world feel when playing with your combos.

Let’s set all this up. We will follow here the guidelines provided by the picture 
in section 4.1.4.

5.3.1. Audio Connections
In order to hear, on your amplification system or headphones, what you are 
playing on your instrument, we will follow these steps.

Physical Connections

First, we have to plug your guitar (or bass) into AUDIO KONTROL 1’s audio 
interface instrument input. 
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As always, before plugging anything into anything, don’t forget to turn any 
relevant signal levels down: on your instrument, and on the Line Input Sensitivity 
Knob (labeled Line) of your AUDIO KONTROL 1 hardware. Now plug the jack 
coming from your instrument into Input 2’s Jack. Because the guitar and the 
bass are high impedance equipment, you must activate the high impedance 
circuitry by engaging the Input Impedance Switch (Inst/Line, position Inst).

There is one more little but important thing to do: adjust the input level. This 
can be done by adjusting the Line Input Sensitivity Knob on the hardware front 
panel while carefully looking at the Input 2 LED on the hardware top panel. 
This LED gives you an idea of the incoming signal level at this input: If there 
is no signal at this input, the LED is off; if there is an incoming signal at an 
acceptable level, the LED lights green; if the incoming signal level is too high, 
the LED turns red. What we want is to have the LED to light green and never 
turn red. To do this, play on your guitar the loudest part that you plan to play, 
and look at the LED: if it is always green, turn the Line Input Sensitivity Knob 
up, until the LED starts turning red. At that point, turn the Knob slightly down, 
until the LED is no longer red. Now, your signal is at the optimum level, giving 
you the highest dynamical range without clipping. You won’t touch this Knob 
again for this application.

Now the input section is done, let’s look at the output. We will choose, for 
example, the first two outputs on AUDIO KONTROL 1’s hardware, as depicted 
in section 4.1.4. If it’s not already done, connect the Main Output Jacks 1 
and 2 on the hardware’s rear panel to your power amplification system (of 
course, only after having checked on your hardware’s front panel that the 
Output Level Knob 1/2 is fully turned down, as well as the volume control on 
your amplifier).

We now have to decide which combo we want to use. You’ve just heard this 
great version of The Kinks’ “You Really Got Me” recorded live at the Kelvin 
Hall on April 1st 1967, and now you are in a kind of British Invasion trip? 
Without hesitation, we will take the AC Box Combo. Launch it and select Preset 
#19, “Amp in the Hall”. That should do the trick! This preset is optimized for 
guitars with humbucker pickups (as denoted by the letters HB after the Preset 
name), but even if you own one with single coil pickups, it won’t make a big 
difference for now.
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Configuring the AC Box Combo

As with TRAKTOR 3 LE, PRO-53 and any other music application, we have to 
quickly check the audio setup in the software. Go in the menu File > Audio + 
MIDI Settings, and click on the Soundcard Tab in the dialog that opens. There, 
check that the selected Output Device is “ASIO AUDIO KONTROL 1”. Then 
click on the Routing Tab, and check the following:

•	 In the Inputs Tab, the inputs must be connected to AUDIO KONTROL 
1’ inputs (actually only Input 2 in our case).

•	 In the Outputs Tab, the outputs must be connected to those used on 
the AUDIO KONTROL 1’s hardware (in our case Outputs 1 and 2).

The Audio is now ready-to-use. You can turn all relevant levels up again (but 
don’t touch the Line Input Sensitivity Knob!). When you play your guitar, you 
should now hear Dave Davies’ riff! 

Note: If you wish to spare your neighbors’ ears, we suggest you to use 
the headphones instead of an amplification system. To do this, just 
plug your headphones into the Headphone Output Jack, disengage the 
Headphone Output Selector Switch so that it monitors the Main Outputs 
1 and 2 (as we used those in our setup), turn the Output 1/2 Level 
Knob all the way down to make sure you don’t accidentally blast your 
neighbours with high volume, and carefully turn the Headphone Output 
Level Knob up. But remember: Using headphones at high levels and/or 
for a long time can be very dangerous for your ears!
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5.3.2. Controlling GUITAR COMBOS
You might love the sound of this preset, developed like the other presets by a 
team of professional sound designers and guitar lovers. But what if you want 
to improve it so that it sounds exactly like YOU want it to sound? Nothing could 
be simpler: you can tweak every combo parameter and save any interesting 
result in a new Preset via the Save function (for more info on this, please 
refer to the GUITAR COMBOS operating manual, included as a PDF file in 
the GUITAR COMBOS installation folder).

But you don’t necessarily need to store each new setting in a new preset. You 
might want to keep an eye on a few parameters, and to be able to quickly 
adapt their values to your playing. AUDIO KONTROL 1 allows you to do this 
in an easy way, without taking the mouse or looking at the computer screen. 
We will just load the right Controller Page in the Mapping Application, and you 
will have the required parameters available on the hardware top panel.

In order to establish a connection between both applications, the AC Box Combo 
needs to receive the MIDI messages coming from the Mapping Application. 
As with setting up the audio connections, open the Audio and MIDI Settings 
within the File menu, select the MIDI tab and activate both input ports of 
AUDIO KONTROL 1. This can be done by clicking on the Off label; if it already 
reads On for both inputs, you don’t need to change the options. Click OK to 
close the dialog box.

Bring the Mapping Application to the front in your operating system. In the 
top Application Control Bar, the first Button is labeled either „Assign” or 
“Display”. If you see “Display”, click on it to switch to the Display View. If 
you see “Assign”, then leave it, as you are already where we need to be: in 
the Display View.

On the right, click on the Page Select menu and select, for example, the entry 
“Guitar Combos AC Box Volume”. The Mapping Application automatically loads 
that Page and you will see all its assignments in the rest of the window.
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The Mapping Application with the “Guitar Combos AC Box Volume Set” Page loaded.

The lower part of the window, called the Hardware Area, represents the 
hardware’s top panel. When you move your mouse above one of the displayed 
Controllers, the upper part of the window, called the Information Area, displays 
the assignments for that Controller.

As shown on the Mapping Application, this Page is quite simple. It implements 
only four controls, corresponding to the following AC Box parameters, now 
accessible from the hardware’s top panel:

Let’s play now with the AUDIO KONTROL 1 hardware top panel:

•	 Without pressing any of the three Buttons, the Controller Knob drives 
the Input Volume.

•	 With the Left Button pressed, the Controller Knob controls the Output 
Volume.

•	 With the Middle Button pressed, the Controller Knob adjusts the Treble 
Booster Boost parameter.
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•	 With the Right Button pressed, the Controller Knob sets the Treble 
Booster Bright parameter.

If you want to have other controls on the hardware’s top panel, feel free to 
load another Page for GUITAR COMBOS AC Box in the Page Select menu, 
or even create your own set(s) of assignments as described in sections 6.2, 
6.3 and 7.4.4.

5.4. Remote Controlling Winamp/iTunes
This last situation deals with an every-day computer task, actually much more 
common than playing a guitar or DJing in a club. It is just about listening to 
music. For that, AUDIO KONTROL 1 will take control of your favorite audio 
player and bring its main commands right to your fingertips. We assume here 
that you are using Winamp on your PC or iTunes on your Mac. Of course, if 
you are using another audio player, you can create one or several User Page(s) 
to control it from AUDIO KONTROL 1’s hardware top panel.

Here we don’t have to make any particular audio connections but the usual 
ones between a computer and a hi-fi or amplification system. We will describe 
them quickly, assuming that you have already read the previous quickstarts. 
After all, it’s only the fourth time that we’ve connected AUDIO KONTROL 1’s 
outputs to an amplification system… If anything is unclear, please refer to 
the previous quickstarts.

•	 Turn all relevant volume controls down.

•	 Connect the Main Output Jacks 1 and 2 to your amplification system.

•	 Plug headphones into the Headphone Output Jack if desired.

•	 Turn all relevant volume controls up to a reasonable level.

That was it on the hardware side. On the software side, the operating system 
needs to use the AUDIO KONTROL 1 as its default interface, as Winamp and 
iTunes are simply relying on the operating system’s settings. The necessary 
steps to set up AUDIO KONTROL 1 as your default audio interface are described 
in sections 4.3.1 (Windows) and 4.3.3 (Mac).

Now we want to load the right Controller Page:

•	 Bring the Mapping Application to the front in your operating system.

•	 In the Page Select Menu, choose “Winamp” (Mac: “iTunes”).

That’s all; everything is now set up to control your audio player from the AUDIO 
KONTROL 1 hardware top panel.

From now on, you will have the following controls via the Controller Knob and 
the three Buttons.
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With no Button pressed:

•	 The Controller Knob controls the volume.

•	 The Left Button doesn’t do anything (see below).

•	 The Middle Button is the Start Button.

•	 The Right Button is the Pause/Continue Button.

With the Left Button pressed:

•	 The Controller Knob can be used to rewind or forward the current 
track.

•	 The Middle Button switches to the previous track in your playlist.

•	 The Right Button switches to the next track in your playlist.

After a few minutes, you will find that the Remote Control is much more 
efficient than grabbing your mouse or your keyboard to perform the same 
actions in the software, notably because you don’t need to bring the target 
application to the front before executing the commands from the AUDIO 
KONTROL 1 hardware.

As always, you are of course absolutely free to compose other Controller Pages 
according to your wishes.

These four quickstarts showed you the basics of AUDIO KONTROL 1. But 
the next section will explain some more complex situations, in which AUDIO 
KONTROL 1 can considerably improve both efficiency and quality in your 
workflow.
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6. Use Cases
We will assume here that you have already read (and understood) the previous 
sections (Parts of the Product, Setup and Quickstarts). If you are an advanced 
user, you don’t necessarily need to have read all these previous sections 
carefully, but we think that it’s always a good idea to spend a few minutes on 
the basics (and if you are an advanced user, it shouldn’t take you too much 
time to read). Moreover, the quickstarts also show you how to start using the 
AUDIO KONTROL 1’s Remote Control, and we will start here from that point. 
If you feel unsure about anything, don’t hesitate to get back to the previous 
sections, or to look in the Reference Section later in this manual.

6.1. Recording Vocals
The first use case that we will look at is recording a voice. AUDIO KONTROL 
1’s audio interface allows you to make high quality voice recordings, assuming 
of course that you have a microphone that is good enough to achieve this… 
AUDIO KONTROL 1 comes with enough connections to set up an efficient 
voice-recording configuration. Actually we will implement here something 
similar to the setup depicted in the section 4.1.1, but without the MIDI part 
(master keyboard…).

6.1.1. What Is the Situation, And How to Connect Everything
You are sitting comfortably in the control room. The song has already been 
recorded, it’s loaded into your favorite multi-track recording software, and 
only the voice track is missing. The singer is standing in the recording room. 
You want to:

•	 record his (her) voice,

•	 send the song to his (her) headphones, so that he (she) can sing on it,

•	 listen to the result live and direct in your control room, i.e. the song 
playback and the voice being recorded.

First, we will plug the microphone’s balanced XLR jack into AUDIO KONTROL 
1’s Combo Input Jack.

Depending on the type of microphone you use for your recording, the Phantom 
Power Switch needs to be activated. You can find it on the rear panel of AUDIO 
KONTROL 1. Please have a look into your microphone’s documentation if you 
are not sure whether to use phantom power or not. Using the incorrect setting 
might damage the microphone.
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Don’t forget to engage the Input 1 Level Switch, so that the incoming signal 
goes through AUDIO KONTROL 1’s microphone pre-amplification circuitry. 
The input signal level is adjustable on the hardware side by the Microphone 
Input Sensitivity Knob. Note that you will probably also have an input level 
control within your recording software.

As we said, we will here follow the diagram as shown in section 4.1.1. In this 
diagram, Outputs 1 and 2 are used for monitoring purposes (i.e. they are sent 
to your control room amplification system). The control signal being sent to 
the singer is coming from Outputs 3 and 4.

So let’s connect your monitoring system to Main Output Jacks 1 and 2 on your 
AUDIO KONTROL 1’s hardware rear panel, and the headphone amplifier device 
to Main Output Jacks 3 and 4.

If you wish, you can plug your own headphones into the AUDIO KONTROL 1’s 
Headphone Output Jack. As you would expect, the Headphone Output Selector 
Switch next to it allows you to switch between your own mix in the recording 
room, and what the singer actually hears in his (her) headphones.

That’s the physical connections dealt with. Now we have to configure our 
recording software accordingly.

6.1.2. Configuring the Recording Software

General Settings

We will assume here that you have already followed the instructions of the 
Setup section and have your AUDIO KONTROL 1 working with your Nuendo/
Cubase/Logic/Sonar/… software.

Here we will be using Steinberg’s Nuendo 3. For other recording-capable 
software, please refer to their operation manuals. The basic recording functions 
are generally quite similar in all of them.

We want to specify in the recording software that the main mix has to be sent 
to AUDIO KONTROL 1’s outputs 3 and 4. To do so, we have to configure the 
virtual busses in the recording software.

In Nuendo 3, open the VST Connections window, available in the Devices 
menu. There, you can set up the busses you need.

Click on the Inputs Tab and check that AUDIO KONTROL 1’s Inputs 1 and 
2 are selected for the input bus you are using (you would actually only need 
Input 1 if you record the voice in mono).

Click on the Outputs Tab and check that AUDIO KONTROL 1’s Outputs 3 and 
4 are selected for the output bus you are using.
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Note: If you wish, you can rename each bus so that you can quickly 
see in Nuendo’s mixer where each track is going (e.g. “Control Room 
Left/Right”, “Input Left/Right”, etc.).

Project Settings

We will assume that you already have a running project for this song, with an 
audio mix down track or several audio tracks to be played back, on which the 
singer will express her (his) talent.

If you have not already done so, open your existing project, or create a new 
one, in which you will set up one mono track for the voice being recorded, 
plus one or several other audio/MIDI tracks for the playback material. Your 
main project window should look more or less like this:

6.1.3. Monitoring Configuration
To listen to what is being recorded, you have two options:

•	 you can either do it in your recording software,

•	 or you can do it via the Direct Monitoring facilities on AUDIO KONTROL 
1’s hardware.

Monitoring Through Your Recording Software

Nuendo 3 (and Cubase SX 3) provides you with an internal monitoring bus, 
already set up, called the “Audition” bus. You have to specify to Nuendo that 
the monitoring signal has to be sent to AUDIO KONTROL 1’s outputs 1 and 
2. To do this, open the VST Connections window again (in the Devices menu), 
and click on the Studio Tab to check that AUDIO KONTROL 1’s Outputs 1 and 
2 are selected for the monitoring bus (the Audition bus).

You will then have to adjust the monitoring level via the bus Aux Send #1 
(destination Audition bus) on your main output bus.

To enable the voice track monitoring, you need to activate its Monitor button, 
on the Mixer, in the main project window or in the track’s Inspector:
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Note that Nuendo 3, like many other modern recording-capable types of 
software, can handle very complex recording setups with different busses/
mixes/settings covering numerous recording issues. Here we show a very 
simple example of a recording setup, as we cannot explain in a few lines what 
a recording software’s manual describes in dozens of pages. For an in-depth 
explanation of what you can do with your recording software, please refer to 
its operation manual.

Direct Monitoring through AUDIO KONTROL 1

AUDIO KONTROL 1 provides you with its own monitoring facilities. This 
solution has some advantages:

•	 It allows you to avoid setting up any monitoring bus in your recording 
software.

•	 The monitor signal is not affected by any potential latency issue.

To activate AUDIO KONTROL 1’s hardware monitoring, follow these steps:

•	 Engage the Monitor On/Off Switch on the hardware’s front panel.

•	 Engage the Monitor Mono/Stereo Switch next to it, so that you can hear 
the voice on both output channels.

•	 In the Mapping Application you can select to which output the input 
signal is monitored. Open the main menu’s Monitoring entry: If the 
singer wants to hear her (his) voice in the headphones, select 1/2 and 
3/4. If the singer does not want to hear her (his) voice, select 1/2, so 
that the voice only goes to your monitoring speakers.

•	 At any time, you can adjust the Monitor Level Knob to control the mix 
between the music track coming from the computer and the voice 
coming directly from Input 1.

6.1.4. Checking the Levels
First, we have to set the input level on the AUDIO KONTROL 1 audio interface. 
This is done via the Microphone Input Sensitivity Knob (labeled “Mic” on 
the hardware’s front panel). The goal is to achieve the highest input level 
possible (in order to get the highest dynamic range and the lowest noise in 
your recording), but not so loud that clipping at the A/D converter occurs. 
To do this, ask your singer to make some noise, approximately at the highest 
level he or she will be singing. Then do the following:



AUDIO KONTROL 1 – 45

•	 First, turn the Mic Knob all the way down.

Turn it up slowly, so that you see the green LED on the hardware’s top 
panel comes on, until the LED starts turning red.

•	 At that point, turn the Mic Knob back down slightly, ensuring that the 
LED never goes red anymore.

•	 Now you’re done; the input level is now set correctly on the hardware 
side.

You might be able to check this input level in your recording software as 
well. In Nuendo, the input level can be displayed on the Input track, on the 
far left of the Mixer. Ensure that the meter displays the pre-fader level: In 
Nuendo, this is done by right-clicking (Mac: Ctrl-click) in the Mixer window 
and selecting Meter Input in the Global Settings submenu. (See your recording 
software manual for more details on this.)

You may also have to be careful about the levels in your recording software, 
depending on how you want to record the voice:

•	 If you want to use EQs and effects directly on the input bus, these 
settings might lower or raise the level of the recorded signal. You would 
then have to check that the effectively recorded signal is loud enough 
but still not clipping. To do this in Nuendo 3, right-click (Mac: Ctrl-
click) in the Mixer window and select Meter Post-Fader in the Global 
Settings. Adjust the fader so that the Clipping indicator does not light 
up.

•	 If you want to record the raw voice as it is, you don’t need to check 
any further levels for the recording.

We recommend you avoid adding any EQs/effects on the input bus, because 
once the voice is recorded, you won’t be able to edit or remove these EQs/
effects. It might be a better idea to record the voice naturally. You will have 
the possibility later to add, remove and edit all the EQs and effects you wish 
on the recorded voice.

6.1.5. Recording the Voice
The last thing to do before starting the recording is to enable the corresponding 
track for recording. In Nuendo, this can be done on the track in main project 
window, in the mixer or in the track’s Inspector, by clicking on the Record Enable 
button next to the Monitor button (the Record Enable button turns red):
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Now everything is ready, you can start the recording via one of the various 
methods described in your recording software operation manual (for example, 
simply click on the Record button in the Transport Bar).

One more time, this is a very short presentation of what you can achieve when 
working with AUDIO KONTROL 1 and any serious recording software. Don’t 
hesitate to spend some time in the recording software manual; it will allow 
you to obtain high quality recordings in more complex setups.

6.2. Controlling a Sequencer - Creating Assignments with Key 
Commands
We will now look at two other cases, in which AUDIO KONTROL 1’s Remote 
Control allows you to pilot your music software as you wish.

The first case deals with a sequencer application. Major sequencers are huge 
pieces of software with hundreds of functions. Depending on what you are 
doing, you often need only part of these functions. Here we will use AUDIO 
KONTROL 1’s ability to reproduce keyboard commands. All major sequencers 
have endless keyboard shortcuts assignments, covering numerous software 
functions. By assigning the most often used functions to the Remote Control, 
you can save time by avoiding the most often repeated mouse and/or keyboard 
actions.

Again, we will use Nuendo 3 as example. Whether you are using this sequencer 
or another, we recommend you refer to your sequencer’s operation manual to 
get all relevant information about the software’s keyboard commands.

6.2.1. Factory Page Overview

Loading a Factory Page

We will start with a Factory Page designed for Nuendo 3.

Bring the Mapping Application to the front in your operating system, and click 
on the Page Select menu in the top Application Control Bar. In the menu, 
select “Nuendo”.

The Controller Page is loaded and the hardware’s top panel assignments are 
now as follows:

With no Button pressed:

•	 The Controller Knob controls the Forward/Rewind commands 
(corresponding to the shortcuts “+”/“-” on the numeric keypad).

•	 The Middle Button controls the Start/Stop command (shortcut: 
space bar)
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•	 The Right Button controls the Record command (shortcut: “*” on the 
numeric keypad)

With the Left Button pressed:

•	 The Controller Knob still controls the Forward/Rewind commands.

•	 The Middle Button now controls the Cycle On/Off commands (shortcut: 
“/” on the numeric keypad)

•	 The Right Button sets the cursor back to zero (shortcut: “,” on the 
numeric keypad).

This set of assignments is definitely transport-oriented: from AUDIO KONTROL 
1’s hardware top panel, you have access to all major transport actions in 
Nuendo. This allows you, for instance, to focus your mouse actions on the 
mixer or on the plug-ins. The Controller Knob is, moreover, a very intuitive 
controller for a forward/rewind action like the jog wheels found on some audio 
or video editing hardware devices.

Analyzing the Assign View

Here we need to take a closer look at these mappings, in order to understand 
how they actually work. Bring the Mapping Application to the front, and switch 
to the Assign View: if you see an Assign Button in the top Application Control 
Bar, click on it; if don’t, you’re already in the Assign View.

In the upper part of the window, called the Selection Area, you will see all the 
Controller assignments. By clicking on one of the four Layer tabs on the left, 
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you select the assignments for that Layer. By clicking then on one of the four 
Controller Areas (or on one of the four upper tabs), you select the particular 
assignment for the corresponding Controller (Controller Knob, Left, Middle 
or Right Button).

Let’s start by clicking on the Main tab on the left. Not surprisingly, in the column 
labeled “Left Button”, you see the word “Modifier”. Indeed, the Left Button is 
used as a modifier in this Page: it does not have any specific action in Nuendo, 
but instead it changes the actions of the other Controllers in Nuendo.

Because this Left Button is set to Modifier mode, the Left Layer (the second 
tab on the left) is available.

Because the other two Buttons are not set to Modifier mode in the Main Layer, 
their corresponding Layer tabs on the left are grayed out and not available.

Click on the first Controller Area, corresponding to the Controller Knob. In the 
lower part of the window, called the Definition Area, you can see all assignment 
details for the Controller Knob in the Main Layer. There, on the left, you can 
see what happens when you turn the Controller Knob to the left, and on the 
right what happens when you turn it to the right. Look at the left part of the 
Definition Area: under the label “Rewind”, you can see a menu with the entry 
“Key”, meaning that the event “turning the Controller Knob to the left” will 
generate a key command in the target application. That target application is 
specified in the following Program menu, in our case “Nuendo”. Below, the 
Key text field displays “Numpad -”, indicating the particular key command sent 
by the hardware event “turning the Controller Knob to the left”.

(Note that key commands are handled slightly different on Windows XP and 
Mac OS X. Refer to section 7.3.4 for more information.)

Now, click on the Left tab. This tab shows you the mappings for the Controllers 
when the Left Button is pressed. You will notice that the Controller Knob 
assignment is the same as in the Main Layer (i.e. when no Button was pressed). 
This allows you to always have control of the Forward/Rewind commands via 
the Controller Knob, whether you press the Left Button or not.

These mappings can be summarized in the following table: 6.2.1.	 Creating 
Your Own Assignments

But you might want to change the behavior of this Controller when you press 
the Left Button, in order to have access to another feature in your target 
application (Nuendo in our case). For example, one could implement a Fast 
Forward/Rewind command when the Left Button is pressed. To do so, you 
just need to do the following:
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•	 Search for the corresponding key command in your target application for 
that specific command. In our case, in Nuendo’s default key commands 
settings, the Fast Forward/Rewind commands are achieved by pressing 
Shift+Numpad +/-.

•	 In the Mapping Application, click in each Key text field and type the 
new key commands on your computer keyboard. The Key text fields 
update the key commands, including the relevant modifier keys: here, 
the Key text fields stay unchanged, but you see that the box “Shift” is 
now activated both in the left and right sections.

•	 Check that the target is set correctly, i.e. that the application and the 
window are set up properly

That’s it! From now on, with no Button pressed, the Controller Knob triggers 
the Forward/Rewind functions, and with the Left Button pressed, it triggers 
the Fast Forward/Rewind functions, giving you more control of the cursor 
position, in a very intuitive way.

Note: If you change the keyboard shortcuts in your target application, 
AUDIO KONTROL 1 mappings won’t be updated! They only send key 
commands. Please check that these key commands are the one you 
need in your target application. Moreover, major sequencers often allow 
you to create whole sets of key commands for different tasks. Don’t 
forget to check the set currently loaded in your application (in Nuendo, 
the key commands are managed by opening the Key Commands dialog, 
available in the File menu).

Let’s say that the Nuendo project that we are currently working on does not use 
any recording functions, it is just a mix down; we won’t be using the Record 
button in Nuendo. The Right Button mapping is therefore not very useful, at 
least in the Main Layer (no modifier Button pressed). You wonder: Is there any 
way to use this Right Button for a more useful function in my project?

We could just replace the Record command by another one that you use more 
often. But there might be something more interesting (at least from the tutorial 
point of view). Here is what we could do:

•	 Transform this Right Button into a modifier Button: We then lose its key 
commands assignment in the Main Layer, but it activates a new Layer 
of assignments for the other Controllers.

•	 In this newly activated Right Layer, map a new key command to the 
Controller Knob, for example the zoom function.
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To do this:

•	 In the upper Selection Area, select the Main Layer tab (on the left) and 
then the Right Button tab (at the top).

•	 In the Definition Area below, click on the menu at the top, that displayed 
“Trigger” until now. Select the entry “Modifier”. The Right Button looses 
its assignments and becomes a modifier for the other Controllers. You 
can see that the Right tab (on the left of the Selection Area) is not 
grayed out anymore.

•	 Click on this newly activated Right Layer tab in the Selection Area to 
specify the new assignments.

For the Controller Knob assignment in this new Right Layer, we want to 
implement the zoom in/out functions. Click on the Controller Knob Area (or 
the Knob tab at the top), and do the following for both left and right sections 
of the lower Definition Area:

•	 First type a label for the left and right actions (e.g. “Zoom out” for 
Rotate Left and “Zoom in” for Rotate Right).

•	 Specify the kind of event you want to send (in our case, “Key” for both 
sides).

•	 In the Program menu, choose “Nuendo”. The menu displays all possible 
target applications currently running.

•	 Click in the Key text field, and enter the Nuendo key commands for 
zooming out/in (by default, the keys “G”/“H” respectively).

The mappings now look like this:

Knob Left Button Middle Button Right Button

Main 
Layer

Forward/Rewind
(Numpad +/-)

Modifier
Start/Stop
(Space)

Modifier

Left 
Layer

Fast Forward /
Rewind (Shift + 

Num pad +/-)

Cycle On/Off
(Num /)

Cursor at Zero
(Num,)

Middle 
Layer

0

Right 
Layer

Zoom In/Out
(H/G)

You could make other changes to this Page by adding other mappings (what 
about a “Zoom out to the entire song” command for the Left Button when 
the Right Button is pressed?). Feel free to implement other assignments so 
that this Page meets your particular needs for your current project.
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You can save your work in a User Page via the Save Button. You cannot 
overwrite the factory Page you loaded initially. Therefore, answer the upcoming 
question with “Save to User Page”, enter a new name (e.g. “FM7 XPRESS 
enhanced”), click OK, and you’re done. You can access the User Pages similar 
to the Factory Pages with the Page Select Menu.

6.3. Controlling a Synthesizer – Creating Assignments with MIDI 
Commands
The third Use Case that we will study deals with controlling a synthesizer from 
the Mapping Application, but this time via MIDI commands instead of key 
commands. Most, if not all software synthesizers can be controlled via MIDI, 
if only by responding to incoming MIDI notes sent from a master keyboard, 
or modifying some filter parameters from a MIDI controller. By the way, the 
AUDIO KONTROL 1’s MIDI interface allows you to connect your MIDI devices 
to your computer to control your software synthesizers.

But here we want to make use of the hardware remote control feature to 
achieve this. This solution offers several advantages:

•	 You don’t need to configure any MIDI controllers (you don’t necessarily 
have any either).

•	 Your Remote Control is always next to your computer, and its controls 
are right beneath your fingers.

•	 You can quickly and easily change, save and recall all mappings, directly 
on your computer.

•	 The Mapping Application remembers at all times what these mappings 
are. (No more questions like “What is the 7th knob on the MIDI 
controller’s middle row doing?” or “Where is my self-adhesive tape? I 
should have written everything down on my MIDI controller”, etc.)

•	 Moreover, AUDIO KONTROL 1’s ability to seamlessly mix both MIDI 
and key commands allow you to design very efficient controlling 
schemes.

If you are using a MIDI controller anyway, the AUDIO KONTROL 1’s hardware 
top panel can still be a very useful additional control device for the most 
important functions in your software.

In this case, we will use another great piece of NATIVE INSTRUMENTS 
software included in the AUDIO KONTROL 1 bundle: the FM7 XPRESS, part 
of the included XPRESS KEYBOARDS.
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FM7 XPRESS is actually quite simple to use. Two Factory Pages are already 
available for FM7 XPRESS. They control the eight knobs above FM7 XPRESS’ 
virtual keyboard.

Most importantly, the application needs to be connected to both the MIDI 
input ports that AUDIO KONTROL 1 provides. Note that only one of them is 
actually present within the hardware. The other port is only virtual. It is used 
to establish a connection between the Mapping Application and the target 
application to be controlled remotely, in this case FM7 XPRESS. In the first 
quickstart we explained how to setup this MIDI connection inside PRO-53. 
The same is true for FM7 XPRESS (and all other applications by Native 
Instruments). Refer to that section 5.1 or to the FM7 XPRESS manual to 
find information on how to configure the MIDI input ports of FM7 XPRESS. 
Because we won’t be repeating all the details every time, we recommend 
that you read the previous Use Case and the former quickstarts to get used 
to the terminology (Layers, tabs, etc.). In any case, you will find all relevant 
information in the Reference section.

6.3.1. Factory Page Overview

Loading a Factory Page

Let’s look at these Pages. If it hasn’t already been done, launch FM7 
XPRESS.

Bring the Mapping Application to the front, open the Page Select menu by 
clicking on it, and select the Page “FM XRESS 1”. The Factory Page now 
loads. On this Page, only the Controller Knob actually directly controls FM7 
XPRESS parameters: the three Buttons are used as modifiers, i.e. they modify 
the Controller Knob behavior when they are pressed and held (like the Shift 
key on your computer keyboard). Here is what the Controller Knob does:

•	 With no Button pressed, it controls the Brightness parameter.

•	 With the Left Button pressed, it controls the Harmonic parameter.

•	 With the Middle Button pressed, it controls the Effect parameter.

•	 With the Right Button pressed, it controls the Pan parameter.

Analyzing the Assign View

In order to understand how this works (and maybe how to modify this…), 
we have to select the Assign View in the Mapping Application via the Assign 
Button, in the window’s top Application Control Bar (if the Button is not visible, 
don’t worry, you already are in the Assign View).
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In the upper Selection Area, you can see all the Controller assignments. By 
clicking on one of the four Layer tabs on the left, you can select the assignments 
for that Layer. By then clicking on one of the four Controller Areas (or on 
one of the four upper tabs), you can select the particular assignment for the 
corresponding Controller. 

Click on the Main tab on the left. For all Buttons, you can see the word 
“Modifier”. Therefore, the three other Layers (Left, Middle and Right) are 
available and can receive other assignments.

Click on the Controller Knob Area. In the lower Definition Area, you have all 
the assignment details for the Controller Knob in the Main Layer (in the left 
section for the “rotate left” action, on the right section for the “rotate right” 
action). In both sections, under the label’s text fields, the Software Event 
Type menu shows the entry “MIDI”, meaning that the two actions “turning the 
Controller Knob to the left/right” will generate MIDI commands. 

Below, we can find all details about the MIDI message to be sent by the 
hardware event “turning the Controller Knob to the left”. The Channel menu 
specifies the MIDI Channel to be used. The Status menu sets the MIDI message 
Status Byte (i.e. the type of MIDI message), in our case “CC Internal”: this type 
of message is used to increment/decrement the value of the Control Change 
(CC) specified by the following Controller menu. In our case, the CC value is 
74, corresponding to the Brightness parameter in FM7 XPRESS. Finally, three 
numeric fields set the increment step (that can be negative to decrement), 
and the minimum and maximum values.
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Note: You have probably noticed that, unlike the Key command setting 
discussed in the previous Use Case, this MIDI command setting does not 
specify any target application. The MIDI message is sent to the computer, 
and every MIDI-capable program running on the computer can receive 
it as long as it listens to both MIDI ports of AUDIO KONTROL 1. If you 
want to be sure that only one program responds to this message, set 
the channel number in the Mapping Application and in your programs 
accordingly.

Clicking on the left tab reveals the mapping for the Controller Knob when the 
Left Button is pressed. This looks very similar to the Main Layer assignment, 
but this time the Controller Knob triggers the Harmonic parameter (CC 71). 
Idem for the two other Layers; only the CC number is different.

These mappings can be summarized in the following table:

Knob Left Button Middle Button Right Button

Main Layer
Brightness

(CC 74)
Modifier Modifier Modifier

Left Layer
Harmonic
(CC 71)

Middle Layer
Effect

(CC 12)

Right Layer
Pan

(CC 10)

6.3.2. Creating Your Own Assignments
As you can see, many cells are left free in this Page. Note that it makes no 
sense to assign a command to the Left Button in the Left Layer: the expression 
“Left Layer” means precisely that the Left Button is already pressed, changing 
the behavior of the other Controllers. The same applies to the Middle Button 
in the Middle Layer and to the Right Button in the Right Layer. Thus, there 
are six free cells in this Page:

•	 Middle and Right Buttons in the Left Layer,

•	 Left and Right Buttons in the Middle Layer,

•	 Left and Middle Buttons in the Right Layer.

Why not use them to control other FM7 XPRESS parameters?

The “FM7 XPRESS 2” Page already controls the four other parameter knobs, 
giving you full control on each FM7 XPRESS Preset. But here we could 
implement a control that would allow you to change the Preset. There is a 
specific MIDI message type for that purpose: the Program Change message. 
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By happy coincidence, FM7 XPRESS recognizes such MIDI Program Change 
messages and switches the loaded Preset according to the Program Change 
number received via MIDI.

The only thing we have to do is to create assignments that will send those MIDI 
Program Change messages to the computer. For that purpose, we will use two 
Buttons: one for incrementing the Preset number and one for decrementing 
it. That way, we will be able to scan through the whole FM7 XPRESS Factory 
Bank.

In the Mapping Application, the Assign View should still be active. If not, bring 
it back by clicking on the Assign Button in the top Application Control Bar.

We have to choose two Buttons from the free cells in the previous table. Let’s 
take for example the Left and Right Buttons in the Middle Layer; this choice is 
quite intuitive: that way, when you press and hold the Middle Button, you can 
scan the Preset Bank in both directions with the Left and Right Buttons.

The Middle Button already is in Modifier mode, we don’t have to change it.

In the upper Selection Area, click on the Middle Layer tab on the left. Everything 
will take place in that Layer.

Now, click on the Left Button tab at the top (or directly in the Left Button Area). 
This displays its assignment in the lower Definition Area. For the moment, there 
is no assignment for that Button: The Hardware Event Mode menu, at the top 
of the Definition Area, shows the entry “None”, (meaning “no assignment”.)

Let’s change that and select the entry “Trigger”. In this mode, the Button 
will send a message every time it’s pressed, and another one every time it’s 
released (on the contrary, the Toggle mode would send a message each time 
the Button is pressed, and another one each time it’s pressed again, but not 
when it’s released).

In the Trigger mode, you can specify a message for the Press state (when you 
press the Button), and another one for the Release state (when you release 
it). This is useful if you want to activate something (such as an effect for 
example,) only when the Button is pressed and held. In our case, we just want 
to send the same Program Change message every time, so here we will only 
use the Press state, and leave the Release state without any assigned action, 
also saving us half of the job.

So let’s check the Press state, in the left section of the Definition Area.

Click on the only visible menu, the Software Event Type menu, and select 
“MIDI”.

Other settings appear as soon as this entry is selected. In the Channel menu, 
select “Omni”, so that the message will be sent on all MIDI channels.
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In the Status menu, choose “PC Internal”. This means that the Program Change 
message will be sent in an incremental way, depending on the last Program 
Change message sent, and not with a constant value.

In the menu below, you can choose if you want to increase or decrease the 
Program Change number. Bearing in mind that we are assigning the Left Button; 
you will probably agree that it’s more convenient to assign the “Decrease” 
action to this Button, and assign the Increase action for the Right Button.

That’s it for the Press state.

As previously mentioned, we don’t need to do anything for the Release state, 
so leave it set to “Off”.

The Left Button assignments are now specified.

Do the same for the Right Button, the only difference being that we have to 
select Increase in the last menu, instead of Decrease.

Now check that when you press and hold the Middle Button, pressing the Left 
Button switches to the previous Preset in the FM7 XPRESS Factory Bank, 
and pressing the Right Button switches to the next Preset.

You can save your work in a User Page via the Save Button. You cannot 
overwrite the factory Page you loaded initially. Therefore, answer the upcoming 
question with “Save to User Page”, enter a new name (e.g. “FM7 XPRESS 
enhanced”), click OK, and you’re done. You can access the User Pages similar 
to the Factory Pages with the Page Select Menu.

Some More Controls

What next? One idea could be to implement the same controls on the second 
Factory Page, “FM7 XPRESS 2”. That way, whether you are using one Page or 
the other, you would always have these Preset Switching controls in the same 
place on your hardware’s top panel, making it even more intuitive.

Another idea could be to implement one or several particular Program Change 
messages for specific Presets that you might want to use on stage, for example. 
You could then make use of the other Program Change message type, “PC 
fixed”, and set a particular Program Change number corresponding to the 
Preset you want to have at your disposal at any time.

Feel free to try other assignments, AUDIO KONTROL 1 offers you endless 
mapping possibilities!
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7. Software Reference
In this section, we will describe all the user interface elements of AUDIO 
KONTROL 1’s software section. As previously mentioned, the software section 
is divided into to programs: the Driver and the Mapping Application (see 
section 3.2).

7.1. The Driver
The Driver is not accessible in itself: like any other driver on your operating 
system, it’s a piece of software loaded in the background when your system 
starts up. The Driver takes care of all audio and MIDI signals coming from or 
going to the AK1 hardware through the USB2 connection.

While the driver does not have a user interface, as stated above, it provides 
interfaces that other applications running on your system can use. These 
interfaces, like ASIO on Windows or CoreAudio on OSX, make it possible to 
use AUDIO KONTROL 1 from within another program (e.g. a sequencer, or 
Winamp/iTunes). You only need to tell the program to use the AUDIO KONTROL 
1 interface. Examples of that process are given in the quickstarts (section 
5) above.

Although the driver itself is inaccessible, you can edit some of its settings to 
modify its behavior for your audio setup. There are different ways to adjust 
those settings, depending on whether you work with Windows XP or Mac OS 
X. Refer to the following chapter for more information.

The Driver also handles remote control messages: it receives hardware actions 
from the AUDIO KONTROL 1 hardware, turns them into hardware events and 
sends these hardware events to the Mapping Application.

7.2. The Driver Control Panel
The Driver Control Panel can be accessed in different ways:

•	 via the link in the Start Menu (Windows) or in the System Preferences 
(Mac)

•	 from the Mapping Application, in the Application Control Bar, via the 
Driver Button (cf. below).
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7.2.1. Driver Control Panel under Windows XP

•	 Presets: Several Presets are included, from minimal latency suitable 
for fast systems that don’t tax the CPU load heavily, to higher latencies 
suitable for slower systems or fast systems with heavy CPU loads. 
Experts can also choose User Defined Settings (see next).

•	 USB Buffersize and Audio Buffersize: These parameters are grayed out 
unless User Defined Settings is selected instead of a Preset. Note that 
the Audio buffer must always be at least twice as large as the USB 
buffer. Together the parameters define the system‘s latency, i.e. the time 
that passes from when a audio signal is sent into the AUDIO KONTROL 
1 hardware, manipulated digitally by the computer and sent back to 
the hardware‘s outputs. Note that the USB Buffersize parameter has a 
very strong effect on the CPU usage of the system. The resulting CPU 
usage differs greatly between different computers, so it makes sense 
to try out several USB settings. The USB Buffersize also has a direct 
impact on the audio buffer, as the audio buffer must be at least twice 
the USB latency.

•	 Sample Rate: Choose a sample rate that is compatible with your music 
application. Higher sample rates use more CPU load, but have the 
potential to offer higher fidelity.

•	 Bit Resolution: Choose the preferred bit resolution. A greater number 
of bits deliver better dynamic range, but audio data recorded at higher 
resolutions requires more memory for storage.
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We recommend trying the first three latency presets first. If you have dropouts 
with the preset “minimal latency”, try the “low latency” or “standard latency” 
settings. The higher you set the audio buffer; the lower is the probability of 
audio dropouts. The presets should be sufficient for most use cases. Please 
activate the User Defined Settings only if you know what the USB Buffersize 
and Audio Buffersize parameters are doing.

There are also two status fields along the bottom that show whether the AUDIO 
KONTROL 1 hardware is ready and connected.

7.2.2. Driver Control Panel under Mac OS X
The Macintosh dialog does not provide any further settings. It only displays 
information about the driver’s version and the firmware revision. If you encounter 
problems with the hardware, this information might be useful when contacting 
the support.

All properties – like latency and sample rate - can be adjusted in the 
applications using the audio interface. You can also access some settings 
from the preferences described in section 4.3.3.

7.3. Remote Control Basic Concepts
In order to fully understand how AUDIO KONTROL 1’s remote control works, 
and to be able to use it at maximum capacity, it is necessary to explain 
the basic concepts of AUDIO KONTROL 1’s workflow concerning its remote 
controlling scheme.

Note that the remote control capacity is handled by the Mapping 
Application. This program needs to be running in order to use this 
function. Normally, it starts up when the computer is booted. It is then 
minimized to the System Tray (Windows XP) or the Status Bar (Mac OS 
X) to keep it in the background. If you cannot find it there, start it from 
the Start menu (or the application’s folder on Mac OS X).

We will describe here four important concepts: hardware actions, hardware 
events, software events and Layers. They all play an important role in the 
Mapping Application, and understanding them will make the use of the Mapping 
Application child’s play. 
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7.3.1. Hardware Actions, or what is done with the Hardware
The hardware actions are performed with the four elements on the hardware’s 
top panel, the Controllers. Here’s what you can do with them:

•	 Controller Knob: Rotate clockwise/counter-clockwise (left/right)

•	 Left Button: Press/release

•	 Middle Button: Press/release

•	 Right Button: Press/release

These actions are transmitted to the Driver, which transforms them into 
hardware events.

7.3.2. Hardware Events, or How Your Computer Understands Them
A hardware event is basically defined by two things:

•	 the original hardware action (for instance, you turn the Controller 
Knob)

•	 how it is understood by the Mapping Application (for instance, defining 
when a movement of the Controller Knob is big enough to be handled 
as a rotation event)

Here is a list of all possible hardware events.

The Controller Knob can be rotated clockwise and counter-clockwise. If a 
Controller Knob movement exceeds a certain threshold, a hardware event 
is generated, either “Rotate Left” or “Rotate Right”. If the Controller Knob 
is moved further in the same direction, after the same amount of rotation a 
subsequent “Rotate Left/Right” event is generated.

For all Buttons, there are three Hardware Event Modes: each Button can be 
used in Trigger mode, Toggle mode, or in Modifier mode, resulting in different 
hardware events:

•	 In Trigger mode, pressing the Button and releasing it creates Press and 
Release events respectively. Both hardware events can be assigned to 
software events. For example, pressing the Left Button could switch 
the B4 XPRESS Rotator Speed to Fast, and releasing the Button could 
switch it back to Slow.

•	 In Toggle mode, pressing the Button creates an On event; pressing it 
a second time creates an Off event. Releasing the Button does not 
create any event. Both On and Off events can be assigned to software 
events. For example, pressing the Right Button could start the playback 
in iTunes, and pressing it again could pause the playback (like a Play/
Pause button).
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•	 In Modifier mode, pressing or releasing the Button does not create any 
event. Instead, the settings for all other Controllers are modified as long 
as the Button is held. (Obviously, it cannot modify itself). This is similar 
to a computer keyboard’s Shift key or Ctrl key that modifies another 
key’s assignment and functionality. For example, in FM7 XPRESS, the 
Controller Knob could adjust the Brightness parameter when no Button 
is pressed, and adjust the Effect parameter when the Middle Button is 
pressed. The Middle Button acts like a modifier.

7.3.3. The concept of Layers, or Making Multiple Uses of One Button
This Modifier function results in four different Layers of hardware events: 
The Main Layer contains all events that are generated without any modifier. 
The other three Layers are only available if the corresponding Button is set to 
Modifier mode in the Main Layer.

The Modifier Mode is only available in the Main Layer. This means in 
particular that you cannot use modifier combinations to define a hardware 
event (as you could on a computer keyboard with e.g. Ctrl+Shift+A).

Depending on the Modifier settings of the three Buttons, there are four (no 
Buttons used as modifiers) to ten (all Buttons used as modifiers) pairs of 
possible hardware events… and as many corresponding software events. The 
picture below illustrates this concept of Layers:

Different configurations of modifiers.

Configuration with 0 modifiers (upper left):

Each Controller can create a pair of hardware events (rotate left/right or button 
pressed/released), thus creating all in all 4 pairs of possible hardware events. 
There is only one Layer, the Main Layer.
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Configuration with 1 modifier (upper right):

Each Controller except the modifier can create a pair of hardware events.

•	 If the modifier (the Left Button in our case) is released, we are in the 
Main Layer, and that makes 3 possible pairs (Controller Knob, Middle 
and Right Buttons)

•	 If the modifier is pressed, we reach the Left Button Layer, and we 
find three other possible pairs, having a total of 6 pairs of possible 
events.

You can define any of the three Buttons as a modifier (the picture above only 
shows one of the three possibilities).

Configuration with 2 modifiers (lower left):

Let’s look at each Layer.

•	 In the Main Layer, two Buttons are set as modifiers. There are two 
remaining Controllers for creating pairs of hardware events (the Controller 
Knob and the Right Button in our case).

•	 If we press the Left Button, we reach the Left Button Layer, which 
contains other assignments for the three other Controllers. In fact, the 
Middle Button, which was a modifier in the Main Layer, becomes a 
normal Button (i.e. in Trigger or Toggle mode) as soon as another Layer 
is selected. As we said in the note above: you can only define modifiers 
in the Main Layer, thus you cannot use combinations of modifiers. Thus 
we have three possible pairs in this Layer: Controller Knob, Middle and 
Right Buttons.

•	 Instead, if we press the Middle Button, we reach the Middle Button 
Layer, where we find three other possible pairs of hardware events 
(for the same reasons as above.): Controller Knob, Left and Right 
Buttons.

That makes a total of 2+3+3 = 8 pairs of possible hardware events.

Once again, you could have chosen another set of two Buttons as 
modifiers.

Configuration with 3 modifiers (lower right):

Once again, let’s look at each Layer.

•	 Main Layer: Only the Knob has a pair of possible hardware events, since 
all the Buttons are set as modifiers.

•	 Left Button Layer: The other three Controllers are available, making thus 
3 possible pairs of events (Controller Knob, Middle & Right Buttons.)
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•	 Middle Button Layer: Like the Left Button Layer, 3 pairs of possible 
events (Controller Knob, Left & Right Buttons.)

•	 Right Button Layer: Like the two above, 3 pairs of possible events 
(Controller Knob, Left & Middle Buttons.)

That makes a total of 1+3+3+3 = 10 pairs of possible hardware events in this 
configuration with all Buttons set to Modifier mode.

Example: If this configuration with three Buttons as modifiers still seems 
strange to you, look at this small example. Imagine that you are working on 
a 3-track project in your favorite sequencer. By correctly setting up your 
AUDIO KONTROL 1 Mapping Application, you could use AUDIO KONTROL 
1’s hardware like follows:

•	 If no Button is pressed (Main Layer), the Controller Knob acts like the 
Master Level Fader in you project’s mixer;

•	 Pressing any Button (other Layers) and holding it would “select” the 
corresponding track in your project;

•	 The Controller Knob would then act like the Level fader for that particular 
track;

•	 The two other Buttons would act like the Solo and Mute buttons for 
that particular track, respectively.

Section 7.4, describing the Mapping Application user interface (below) will help 
you in getting familiar with this concept of Layers. It’s a key concept, which 
allows you to multiply the assignment possibilities of your AUDIO KONTROL 
1. Some of the quickstarts (section 5) and Use Cases (sections 6) show 
examples of using this Modifier mode.

7.3.4. Software Events, or What Is Actually Sent To Your Applications
The hardware events that we described above are processed by the Mapping 
Application and transformed into software events routed to the desired 
application running on your computer. As soon as you execute a hardware 
action, the Mapping Application sends the corresponding software event to 
the application in the form of a key command or a MIDI message:

•	 Key Commands simulate an action on the computer keyboard in the 
target application (commonly called a “keyboard shortcut” for that 
application). Note that even if the target application is minimized in 
the system tray (Windows) or in the Dock (Mac), it will still receive the 
key command.
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Note that key commands are handled differently on Windows XP 
and Mac OS X. On Windows, the key command is sent to the target 
application’s main window. On Mac OS X, however, there is no main 
application window. Therefore, the key command is sent to the currently 
active window if the target application is in the foreground. If the target 
application is in the background, the key command is sent directly to 
the application and not to one of its windows. Depending on the target 
application, some key commands can become inaccessible due to this 
particularity of Mac OS X.

•	 MIDI Messages can also be used to send commands, as almost all 
music applications support this type of remote control.

The MIDI Messages are sent using a second, virtual MIDI port. The 
application you want to control remotely with MIDI messages needs 
to be connected to that virtual MIDI port - make sure that the target 
software’s MIDI interface is setup correctly.

All details about these key commands and MIDI messages can be found in 
section 7.4.4 describing the Mapping Application’s Assign View.

7.3.5. Taking Stock
Now let’s take a short break and try to sum up what we’ve just learned about 
the remote control signal flow.

The AUDIO KONTROL 1 hardware transmits your commands in the form of 
hardware actions.

These hardware actions are transformed into hardware events, depending on 
how the actions should be interpreted (which Controllers are manipulated, on 
which Layer, in which Mode…).

The Mapping Application receives these hardware events and maps them to 
the desired application, in the form of key commands or a MIDI messages.

Your application executes the task as expected upon reception of the 
command.

The next section will describe how to configure all these tasks via a few mouse 
clicks with the Mapping Application.
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7.4. The Mapping Application
The Mapping Application is the control tower of your AUDIO KONTROL 1’s 
remote control system. It stores the links between hardware actions (what 
you do on AUDIO KONTROL 1 top panel) and software events (what you want 
to be done within a specific piece of software). Here we will systematically 
describe all elements of the Mapping Application user interface that controls 
and organizes the formerly explained hardware and software actions/events 
and other Layers.

Of course, we strongly recommend that you try each element on your Mapping 
Application as we describe it in the manual. Learning-by-doing-by-manual-
reading is the key to success!

The Mapping Application offers two view modes: the Display View and the 
Assign View. Both share the Application Control Bar at the top of the window. 
Let us look at each of them thoroughly.

7.4.1. The Application Menu Bar
The Mapping Application menu bar contains three menus: the File menu, the 
Monitoring menu and the Help menu.

File Menu

The File menu allows you to manage the Controller Pages, to access the Driver 
Control Panel and to quit the Mapping Application. The menu contains the 
following entries:

•	 New Page: Loads the file “New.xml” that is found within the Factory 
Pages folder. If the Page was changed after the last save, a warning 
dialog asks for confirmation as all unsaved data will be lost by executing 
this command.

•	 Open Page: Provides a list of pages similar to the Page Select Menu 
within the Application Control Bar.

•	 Save Page: Saves the Page with its current name, like the Save Button 
within the interface. If the Page was loaded from the Factory Pages 
folder, a dialog comes up informing about the fact that the page will 
be saved to the User Pages folder. If you agree, choose Save to User 
Content; if not, choose Cancel. If the Page’s current name is New (i.e. 
it was created by the New Page command), the command is similar to 
the Save Page As... command.

•	 Save Page As...: Brings up a dialog that lets you enter a name for the 
Page. A warning dialog asks for confirmation if the chosen filename is 
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already used; you then can choose whether to Replace the Page already 
existing or to Cancel and choose another name.

•	 Delete Page...: This entry is inactive if a Factory Page is loaded. If a User 
Page is loaded, it brings up a warning dialog asking for confirmation 
(with the self-explaining options Delete and Cancel). After deletion, the 
file “New.xml” is loaded automatically.

•	 Audio Settings...: Opens the Driver Control Panel (like the Driver Button 
in the Application Control Bar). For more info in the Driver Control 
Panel, see section 7.2.

•	 Exit: Quits the Mapping Application. Note that the AUDIO KONTROL 
1’s top panel remote control will then be deactivated, since it needs 
the Mapping Application to be running in order to function properly.

Monitoring Menu

This menu allows you to select the output pair from the four Main Output 
Jacks to which the Direct Monitoring signal has to be sent. You can choose 
pair 1/2, 3/4, or both. (For more info on how to use Direct Monitoring, see 
sections 3.1.1 for the theory and 6.1 for the practice.).

Help Menu

The Help menu provides you with the following entries:

•	 About: Opens the About dialog (like clicking the NATIVE INSTRUMENTS 
logo or the AUDIO KONTROL 1 logo). This dialog contains valuable 
information about the software such as the version number.

•	 Visit Audio Kontrol 1 on the web: Opens in your internet browser the 
AUDIO KONTROL 1 page on the Native Instruments website.

7.4.2. The Application Control Bar
The Application Control Bar is always visible. It contains the Mapping Application 
global commands like switching between both Views, managing your Controller 
Pages, and activating the Driver Control Panel.

The Application Control Bar is always visible.

Assign/Display Button

This Button allows you to switch between the two View Modes of the Mapping 
Application. Depending on which mode the Mapping Application is currently 
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in, the Button shows the name of the other mode. Click on the Button to 
switch to the other View Mode.

Page Select Menu

The Page Select menu provides the list of available Controller Pages. You can 
open it by clicking with the mouse; selecting an entry then loads the page. 
Each page includes a full set of Controllers Assignments.

Each Page is stored as a separate XML file. Pages are of two types:

•	 AUDIO KONTROL 1 comes with an extensive set of prepared Factory 
Pages for various NATIVE INSTRUMENTS products, major sequencers 
and multimedia applications. These Pages cannot be edited.

•	 You can also create your own User Pages, e.g. by customizing a Factory 
Page.

The Page Select menu shows all available pages: At the top there are the 
User Pages. They are followed by the Factory Pages which are separated by 
a small line. If there are no User Pages, e.g. because you did not create save 
one yet, only the Factory Pages are shown.

Save Button

A click on the Save Button saves the page with its current name, similar to the 
Save entry within the File menu. If the page is a Factory Page, a dialog comes 
up informing about the fact that the page will be saved to the User Pages 
folder. If you agree, choose Save to User Content; if not, choose Cancel. If the 
Page’s current name is New (i.e. it was created by the New Page command of 
the File menu), the button is similar to the Save Page As... command.

Driver Button

The Driver Button opens the Driver Control Panel. For more info, please refer 
to the section 7.2.

AUDIO KONTROL 1 Logo and NATIVE INSTRUMENTS Logo

Clicking on the AUDIO KONTROL 1 Logo or on the NATIVE INSTRUMENTS Logo 
opens the About dialog. This dialog contains valuable information about the 
software such as the version number.

7.4.3. The Display View
The Display View allows you to see what the current assignations are for the 
four Controllers on your AUDIO KONTROL 1 top panel.

If the Display View is not active, click on the Display Button in the Application 
Control Bar (if there is no Display Button in the Bar, it means that you are 
already in the Display View…)
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The Display View of the Mapping Application, with its Information Area above and its Hardware 
Area below.

The Display View consists of two areas: The lower Hardware Area displays 
the AUDIO KONTROL 1 hardware top panel. In the upper Information Area, 
information text is displayed, depending on the mouse position within the 
Hardware Area. If you position the mouse over one of the elements in the 
Hardware Area, the Information Area will update to display all mapping 
information for this particular Controller.

7.4.4. The Assign View
The Assign View allows you to precisely define the action of each Controller 
on the hardware’s top panel. As we described in the previous section 7.3, 
each human interaction with a Controller induces a hardware action that is 
translated by the Driver into a hardware event, itself transformed by the Mapping 
Application into a software event sent to the corresponding application. If this 
sounds new to you, please refer to the above-mentioned section.

The Assign View is the place where you configure this translation between 
hardware actions and software events.

If the Assign View is not active, click on the Assign Button in the Application 
Control Bar (if there is no Assign Button in the Bar, it means that you are 
already in the Assign View.)

Like the Display View, the Assign View is split into two areas: the upper 
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Selection Area and the lower Definition Area. Basically, the Selection Area 
specifies the element whose mapping is set in the Definition Area.

The Assign View of the Mapping Application, with its Selection Area above and Definition Area 
below.

Selection Area

The Selection Area consists of four Controller Areas, laid out horizontally, and 
four vertical Layer Tabs.

The Controller Areas represent the four Controllers (Controller Knob and Left, 
Middle and Right Buttons). Each of them displays the Hardware Event Mode 
of that Controller (e.g., Toggle, Rotate) as well as both Event Labels (e.g. On: 
Activate Reverb; Off: Deactivate Reverb). They can be selected via the mouse. 
When a Controller Area is selected, the corresponding element’s settings are 
displayed in the lower Definition Area.

The Layer Tabs select the Layer for the Controller Areas. Clicking on the Main 
Tab will for instance display the Controller Assignments of the Main Layer, i.e. 
when no modifier is pressed. If the Right Button is set to Modifier mode in 
this Main Layer Tab, then clicking on the +Right Tab will display the Controller 
Assignments defined when the Right Button is pressed.

If a Button is not set as a modifier, the corresponding Layer Tab is not active 
and its Label is grayed out.
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Definition Area

The Definition Area displays the settings related to the Controller Area selected 
in the Selection Area above. It also allows you to adapt these settings to your 
needs and tastes.

At the top middle of the Definition Area, we find the Hardware Event Mode menu, 
which allows you to select the desired Hardware Event Mode for the Controller. 
It contains the entries Toggle, Trigger and Modifier for the Buttons. For the 
Controller Knob, it is always set to Rotate and cannot be modified, since it is 
the only mode possible for that Controller.

If Modifier is selected for a Button, there are no further options for the 
corresponding Button (since obviously a Button cannot be a modifier and 
control a software event at the same time.) Therefore the whole Area is 
disabled.

The rest of the Definition Area is divided into two identical sections, on the 
left and on the right. Each of them defines one of the two Hardware Events 
relating to the corresponding Controller Area. Both contain the following 
elements, from top to bottom.

The Event Type Indicator shows the two possible states of the Controller, 
depending on the Hardware Event Mode selected in the previous menu:

•	 Rotate: Left on the left side, Right on the right side.

•	 Toggle: On on the left side, Off on the right side.

•	 Trigger: Press on the left side, Release on the right side.

The Event Label Field holds the name of the respective action. By clicking 
on the Field, you can enter the desired Label. Press the Enter key on your 
computer keyboard to save the new name. This Event Label is used within the 
corresponding Controller Area (in the upper Selection Area) and in the Display 
View’s Information Area to summarize the Controller’s functionality.

The Software Event Type menu lists the possible Software Event Types that 
can be assigned to the Hardware Event chosen in the upper Selection Area. 
These are:

•	 Off: The mapping for this Hardware Event is de-activated.

•	 Key: Sends a Key Command that simulates an action on the computer 
keyboard in the target application.

•	 MIDI: Sends a MIDI Message to the target application.

Below, the Specification Area contains all information defining the specific 
Software Event to be executed. Depending on the Software Event Type selected 
in the previous menu, the Specification Area provides different elements.
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If Off is selected in the Software Event Type menu, the Specification Area is 
disabled:

No Specification Area if Off is selected.

If Key is selected in the Software Event Type menu, the Specification Area 
offers elements allowing you to specify a Key Command:

Specification Area for the Key Software Event Type.

These elements are, from top to bottom:

•	 Program menu: This menu allows you to choose the target application 
for this Hardware Event. The menu lists all currently active applications 
that can receive key commands. Their status (window active or not, 
window displayed or not, minimized or hidden, etc) does not interfere 
with this selection.

•	 To the right of the Program menu, a Browse Button (…) brings up a 
file browser dialog box to select an application that is not currently 
running.

•	 Key: This text field and its four modifier key boxes below allow you to 
enter the desired keyboard shortcut. After clicking on the field, press 
the shortcut on your computer keyboard and the Mapping Application 
stores it, with the corresponding modifier keys. These modifier keys 
are Shift, Ctrl, Alt and Win on Windows systems and Shift, Ctrl, Alt 
and Apple on the Mac.
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•	 Continuous Switch: This switch activates the Continuous Mode: Normally, 
a key command is generated by simulating a key being pressed and 
released immediately afterwards. This keystroke is sufficient in most 
situations. However, sometimes it is necessary to simulate a key that is 
held down for a given time. This can be simulated with the Continuous 
Mode. It simulates the key being pressed when the hardware event 
arrives, for instance when the knob is rotated in either direction. But 
instead of simulating the key release immediately afterwards, the release 
is only generated when the knob stops moving. Thus, the key is “held” 
until the rotation ends. Due to this structure, the Continuous Switch 
can only be activated for Rotate events and for the Press event of the 
Trigger mode, i.e. not for Release, On or Off.

If MIDI is selected in the Software Event Type menu, the Specification Area 
provides you with the MIDI Message parameters to be sent

The MIDI Messages are sent using a second, virtual MIDI port. The 
application you want to remotely control with MIDI messages needs 
to be connected to that virtual MIDI port - make sure that the target 
software’s MIDI interface is setup correctly.

Specification Area for the MIDI Software Event Type.

The Channel menu selects the MIDI channel on which those messages are sent. 
You can choose between all 16 channels, and it includes an Omni entry (the 
default setting) that sends the message in omni mode, i.e. on all channels.

The Status menu selects the type of MIDI message sent. Technically speaking, 
this defines the message status byte (for more info on what a status byte is, 
please refer to some MIDI specification reference). Depending on the selected 
entry in this menu, the area below displays relevant dedicated elements. The 
menu provides the following entries:
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•	 Note: Sends a MIDI Note On message. Two dropdown menus specify 
the message’s pitch and velocity (see the screenshot above). If the 
velocity is set to zero, the message will be interpreted as MIDI Note 
Off. This can be used to trigger samples in a sampler or phrases in a 
sequencer.

•	 Aftertouch: Sends a MIDI message defining a key’s Aftertouch. Two 
dropdown menus specify the message’s Pitch and Pressure. The Pitch 
menu offers an All entry: If this entry is selected, MIDI Channel Pressure 
messages are sent; in all other cases Polyphonic Key Pressure messages 
are sent.

•	 CC Fixed: Sends a MIDI Control Change message. Two dropdown menus 
specify the message’s Controller Number and the Controller Value to 
be set. This can be used, for example, to switch an effect or any other 
status on or off, e.g. by sending CC value 127 upon a hardware press 
event, and CC value 0 when the button is released again.
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•	 CC Internal: Sends a MIDI Control Change message. A dropdown menu 
specifies the message’s Controller Number. Three additional value 
fields specify the step size (it can be negative), and the minimum and 
maximum values that the controller can use; higher or lower values are 
cut. This can be used to change a controller value continuously, e.g. 
the modulation wheel, or an effect’s depth.

If you change the controller value in the target application by another 
means (with the mouse for example), the target application will not 
communicate this to the Mapping Application. A subsequent CC Internal 
message triggered with AUDIO KONTROL 1 might therefore cause a 
sudden jump of the controller value!

•	 Program Change Fixed: Sends a MIDI Program Change message. A 
dropdown menu specifies the message’s Program Number.

•	 Program Change Internal: Sends a MIDI Program Change message. A 
dropdown menu specifies whether the Program Number is increased 
(Next Program) or decreased (Previous Program). It can be used to 
continuously step through a plug-in’s patches.
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If you change the program number in the target application by another 
means (with the mouse for example), the incoming PC Internal message 
might cause a sudden jump of the program number!

•	 Channel Mode: Sends a MIDI Channel Mode message. A dropdown 
menu selects whether this message is an All Sound Off message, an 
All Notes Off message, or both combined. This can be useful as a Panic 
Button.

•	 Extended: Sends a generic MIDI string. It contains a Text Field for entering 
the MIDI string. The string is entered byte-wise. The bytes are separated 
by blanks and/or commas. The byte’s value can be entered in decimal 
or hexadecimal notation. The hexadecimal notation is indicated by an 
“h” succeeding the byte value without blank or comma. The Channel 
menu has no effect when sending extended MIDI messages. This can 
be used to generically encode all MIDI messages, particularly SysEx 
commands. Combined with the MIDI Learn feature, it can even be used 
to record small MIDI phrases that can then be played-back directly 
from the hardware.

Clicking on the Learn switch activates the MIDI Learn mode. The Mapping 
Application then listens to messages on the driver’s MIDI stream, allowing 
you to enter the MIDI message from any MIDI controller or master keyboard. 
It does not affect the Channel and Status selection - instead the messages 
are filtered by these settings. This keeps the Learn mode selective regarding 
specific modes like CC Fixed/Internal etc. If Extended is selected with the 
Status menu, all messages are learnt without filtering, the only exception being 
MIDI real-time messages. In Extended mode subsequent messages can also 
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be learnt; in all other cases, a new message overwrites the previous setting.

To switch the MIDI Learn mode off, click on the Learn switch again.

7.5. Add-on Software
AUDIO KONTROL 1 features three great products by Native Instruments: 
XPRESS KEYBOARDS, GUITAR COMBOS and TRAKTOR 3 LE are part of the 
software package, beside the Mapping Application. These products provide 
their own dedicated documentation that can be found within their respective 
installation directories. You can also use the links placed within the Start 
Menu (the applications’ folders on Mac OS X).

Please note that these products need separate registration, using the NATIVE 
INSTRUMENTS Service Center. For more info on the registration process, 
please refer to the separate Setup Guide, located in your installation folder.

8. Optimizing and Troubleshooting

8.1. Hardware Troubleshooting
Native Instruments hardware products meet the highest professional standards. 
All products are tested extensively in real life situations during the development 
phase. However, should you encounter any problems with your hardware, 
please follow these steps for troubleshooting:

•	 Verify that you have installed the latest driver and the latest software 
update. Check the Native Instruments website for information.

•	 Make sure that the AUDIO KONTROL 1 hardware is connected to a 
USB 2.0 port on your computer.

•	 Make sure you are connecting directly to a USB port on the computer 
and not through a USB hub.

•	 Try another USB cable.

•	 Disconnect any other USB devices from the computer (except keyboard/
mouse).

•	 Try using any other USB ports on your computer.

You can find more detailed information on these steps in the following 
sections.
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However, if your product needs to be returned, the Technical Support team will 
assign you an RA (Return Authorization) number to expedite the processing of 
your return. Please contact our Technical Support team prior to returning any 
item. The contact information is available under the following URL:

http://www.nativeinstruments.de/index.php?id=contactinfo_us

Packages returned without this RA number will not be correctly identified and 
as such might not be processed properly.

8.2. How to check if the driver is installed correctly?
On a PC in the Windows Start menu there should be a new entry called 
“Native Instruments Controller Driver”. There you will find the helper applications 
“Audio Statistics” and “Control Panel”. Make sure that the   Controller is 
connected to the computer and open the Control Panel. If all the drop-down 
menus are grayed out (i.e., there are no presets in the preset drop-down list, 
no sample rate and bit rate values) there must be something wrong with the 
connection. If the “Native Instruments   Controller Driver” entry in the Start 
Menu is missing, the driver is most probably not installed at all.

Control Panel PC – AUDIO KONTROL 1 not connected



78 – AUDIO KONTROL 1

Control Panel PC – AUDIO KONTROL 1 connected

On a Mac, look into the System Preferences for the NATIVE INSTRUMENTS 
USB Audio Control Panel icon. Open this control panel to see if the device is 
found. If no device is found the Control Panel values will appear grayed out. 
If the NATIVE INSTRUMENTS USB Audio Control Panel icon is missing here, 
the driver is probably not installed at all.

If the driver is not installed, you can install it using the setup program described 
in section 4.2 of this manual.

If the Controller is not recognized, here are a few things you should check. 
See the following sections for details.

8.2.1. USB 2.0 required
The Controller is a USB 2.0 interface and will not work at all on a USB 
1.0/1.1 port. 

In addition, although the minimum power specified for a USB 2.0 port is 500 
mA, we have seen a few cases where the USB 2.0 ports on certain computers 
do not fulfill the minimum requirements and therefore do not meet the official 
USB 2.0 specification. In this case you may see a message saying that there 
is not enough power available to operate your device.

In this case the Controller might produce crackles or might not even work 
at all.
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8.2.2. Try another USB cable
A bad USB cable can be responsible for audio dropouts and other connectivity 
problems. It is highly recommended that you try using a different cable if you 
are experiencing difficulties; make sure to use a cable bearing the official 
USB logo.

8.2.3. Using a powered USB 2.0 hub
It is best to connect the AUDIO KONTROL 1 directly to a USB 2.0 port on 
your computer. However, in certain situations a powered USB hub can also 
be a solution if you are having problems connecting your AUDIO KONTROL 
1 to an onboard USB port. In this case you should avoid connecting other 
devices to the hub if you can as they will take diminish the total amount of 
power available. 

8.2.4. Disable USB energy saving mode 
If you’re having problems with AUDIO KONTROL 1 crashing or performing badly 
on a Windows machine, the first thing to do is to disable power management 
to the USB hubs. XP turns this on by default. Go to device manager (Control 
Panel/system/hardware) and right click a USB hub to bring up properties. On 
the power management page, uncheck all boxes. Repeat for each hub and 
reboot.

8.2.5. Update the Driver
Check the Native Instruments website regularly for updates of the AUDIO 
KONTROL 1 driver. 

8.3. How to use the remote control function?
Note that the remote control capacity is handled by the Mapping Application. 
This program needs to be running in order to use this function. So, in case the 
remote control function is not working, you might want to check whether the 
Mapping Application is running. Normally, it starts up when the computer is 
booted. It is then minimized to the System Tray (Windows XP) pr the Status 
Bar (Mac OS X) to keep it in the background. If you cannot find it there, simply 
start it from the Start menu (the application’s folder on Mac OS X).

If this does not help (i.e. the Mapping Application is running but you cannot use 
the remote functionality), the problem might be caused by a non-established 
MIDI connection. In order to control an application (e.g. a virtual synthesizer 
like FM7 XPRESS) with MIDI messages, the target application needs to be 
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connected to both MIDI ports of the AUDIO KONTROL 1 hardware. Please 
verify that they are activated correctly within the target application.

However, not all programs are controlled via MIDI, e.g. Winamp or iTunes 
are controlled with key commands and don’t require a MIDI connection. If 
those applications cannot be controlled correctly, check within the Mapping 
Application’s Assign View whether the loaded page accesses the correct 
application and window. Refer to chapter 7.4.4 for detailed information about 
the Assign View.

8.4. How to avoid Ground Loops
Ground loops are a common problem within any environment where multiple 
electrical devices are connected to the same power circuit. In complex setups 
the cause(s) of the noise can be difficult to find. Ground loops are perceived 
usually as a hum or buzz in your audio signal, but this can also transmit and 
amplify other sounds from the devices connected to the circuit. For example, 
one very common problem is that you hear internal clicking sounds created 
by your computer. 

The cause of the noise is usually the computer and its internal devices, or 
devices connected to the computer like external hard drives. (Note that even 
if the power supply of your notebook computer is not connected, your setup 
may still be vulnerable to ground noise from an external device with its own 
power supply.) The cause can also be any other device (such as a television) 
connected to the same mixer. 

The reason why this noise is present at the monitor speakers input has to 
do with a loop in the setup of electrical and audio cable connections in your 
studio. Most likely this loop occurs through the ground of one or more of 
these cables. With this in mind, the following points should help to eliminate 
the ground loop:

8.4.1. Try to eliminate the loop
Assuming that you have connected the AUDIO KONTROL 1 to a mixer, a first 
troubleshooting step is to disconnect all devices from your mixer that you are 
not currently using. This applies also to other peripheral devices you may have 
connected to your computer (external data storage, CD burners).

8.4.2. Use balanced cables
Always use balanced audio cables if possible to connect the AUDIO KONTROL 
1 to your mixer. If your mixer provides both unbalanced and balanced inputs, 
avoid using the unbalanced inputs if you can. 
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8.4.3. Break the loop with a DI box
If you cannot fix the ground noise problem by disconnecting equipment and 
using balanced cables, you still have the possibility of using a DI (direct input) 
box between the AUDIO KONTROL 1 outputs and the mixer inputs. (This is 
the same kind of box that is used to connect a line-level instrument like a 
guitar). Most of these boxes have a ground lift switch on them, this can be 
used to break the ground loop and eliminate the noise. A DI box is especially 
recommended if your mixer has unbalanced inputs only.

8.5. How to Use AUDIO KONTROL 1 with a Laptop

8.5.1. Check the Laptop’s latency
First you should check if your computer is suited to handling real-time audio 
processing without experiencing dropouts. Dropouts might be caused by certain 
components in your computer. Please download a tool that scans your computer 
regarding suitability for audio processing. You can find an appropriate one at 
www.thesycon.de/deu/latency_check.shtml. There is no Software installation 
required, just launch the tool after downloading.

With AUDIO KONTROL 1 disconnected the tool will report if your Laptop can 
handle real-time audio streaming without dropouts. 

DPC without AUDIO KONTROL 1 disconnected
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DPC with AUDIO KONTROL 1 connected

In case your Computer is unable to handle glitch free audio processing, the 
tool will show you red latency bars and report this in the box on the bottom. 
Run it with both settings – AUDIO KONTROL 1 connected and disconnected 
– to find out about your computer’s capacities. 

8.5.2. Avoid Shared Memory
In general it is not recommended to use laptops with shared-memory graphic 
cards. A Shared-memory graphic card accesses to the same memory as the 
CPU. Other Graphic Cards have their own memory, so that the main memory is 
reserved for the audio processing. You’ll need memory and processing power 
available for your audio project.

8.5.3. Avoid Battery Usage
It is not recommended to run the laptop on its battery, as the computer might 
slow the clock rate of the CPU down.

8.5.4. Disable Devices
First, disconnect additional hardware (printers, scanners etc.) that you don’t 
need while you are working with AUDIO KONTROL 1. Thus, the computer 
does not need to handle superfluous devices.

Beside that, laptops often are equipped with built-in devices that disturb 
audio processing. An example is a wireless LAN card. In case you experience 
serious dropouts, you might need to disable these devices while working with 
AUDIO KONTROL 1.
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Windows XP

To do so, please go to the device manager (Start>Run and type ‘devmgmt.
msc’).  You can disable a device (let’s say the network adapter) by clicking on 
network-adapter and double clicking on the device to bring up its properties 
dialog. On the bottom of this pane you can disable the device via the Scroll-
Down menu. Please deactivate it and hit “OK”.  You should see a red cross 
over the device, which means that it has been deactivated.

Common built-in devices are: network adapters, wireless LAN cards, bluetooth 
ports, infrared ports, printer ports etc. Try to disable the network adapter 
and wireless LAN card first, as they are the most common problem causing 
devices in audio processing. Make sure that you don’t disable devices that are 
indispensable for your laptop to work properly. Here is a list of devices that 
you should not deactivate: System timer, Keyboard, System CMOS/real time 
clock, Microsoft ACPI-Compliant System, Numeric data processor, Primary 
IDE Channel, Secondary IDE Channel, Graphics Controller, Ultra ATA Storage 
Controllers.

Macintosh OS X

If you have a wireless LAN card installed and Bluetooth running turn them 
off while you are using AUDIO KONTROL 1 (you can turn this off in the top 
OSX menu bar). 
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9. Appendix

9.1. Technical Specifications and Block Diagram
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Audio Inputs (A/D)  
Channels 2
Sample Rate: 44.1, 48, 96, 192 kHz
Bit Resolution: 16, 24 Bit
Converter Cirrus Logic

Line Inputs  
Input Impedance:  44 kOhms balanced
Full Scale Level 
at maximum Gain  ������ +2 dBu

Maximum Input Level:  +16 dBu
SNR (weighted):  100 dB
THD+N:  0.006%
Frequency Response: 20 - 20000 Hz (+0 / -0.5 dB)

Mic Input  
Input Impedance:  4.8 kOhms balanced
Full Scale Level 
at maximum Gain  ������� -40 dBu

Maximum Input Level:  +10 dBu
SNR (weighted):  100 dB
Equivalent Input Noise:  -128 dBu (weighted)
THD+N:  0.007%
Frequency Response: 20 - 20000 Hz (+0 / -0.5 dB)

Instrument Input  
Input Impedance:  1 MOhms unbalanced
Full Scale Level 
at maximum Gain  ������ -4 dBu

Maximum Input Level:  +10 dBu
SNR (weighted):  100 dB
THD+N:  0.006%
Frequency Response: 20 - 20000 Hz (+0 / -0.5 dB)
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Audio Outputs (D/A)  
Channels 4
Sample Rate: 44.1, 48, 96, 192 kHz
Bit Resolution: 16, 24 Bit
Converter Cirrus Logic

Line Outputs  

Output Impedance:  100 Ohms unbalanced,  
 200 Ohms balanced

Maximum Output Level:  +13 dBu
SNR (weighted):  103 dB
THD+N:  0.005%
Frequency Response: 20 - 20000 Hz (+0 / -0.5 dB)

Headphone Outputs  
Load Impedance:  8 ... 600 Ohms

Maximum Output Level:  4.26 V rms, 
 100 mW @ 100 Ohms

SNR (weighted):  102.5 dB
THD+N (60 Ohms):  0.006%
Frequency Response: 20 - 20000 Hz (+0 / -0.5 dB)

Other Interfaces  
Interface to computer: USB 2, bus powered
MIDI: 1 Input, 1 Output

Control Elements  
Endless Knobs: 1
Buttons: 3

Dimensions  
Height:  52 mm
Width:  150 mm
Depth:  123 mm
Weight:  400 g
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9.2 MIDI CC Table
0 Bank Select 0-127
1 Modulation Wheel 0-127
2 Breath Controller 0-127
3 Undefined 0-127
4 Foot Controller 0-127
5 Portamento Time 0-127
6 Data Entry MSB 0-127
7 Channel Volume 0-127
8 Balance 0-127
9 Undefined 0-127
10 Pan 0-127
11 Expression Controller 0-127
12 Effect Control 1 0-127
13 Effect Control 2 0-127
14 Undefined 0-127
15 Undefined 0-127
16 General Purpose Controller 1 0-127
17 General Purpose Controller 2 0-127
18 General Purpose Controller 3 0-127
19 General Purpose Controller 4 0-127
20 Undefined 0-127
21 Undefined 0-127
22 Undefined 0-127
23 Undefined 0-127
24 Undefined 0-127
25 Undefined 0-127
26 Undefined 0-127
27 Undefined 0-127
28 Undefined 0-127
29 Undefined 0-127
30 Undefined 0-127
31 Undefined 0-127
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32 LSB for Control 0 (Bank Select) 0-127
33 LSB for Control 1 (Modulation Wheel) 0-127
34 LSB for Control 2 (Breath Controller) 0-127
35 LSB for Control 3 (Undefined) 0-127
36 LSB for Control 4 (Foot Controller) 0-127
37 LSB for Control 5 (Portamento Time) 0-127
38 LSB for Control 6 (Data Entry) 0-127
39 LSB for Control 7 (Channel Volume) 0-127
40 LSB for Control 8 (Balance) 0-127
41 LSB for Control 9 (Undefined) 0-127
42 LSB for Control 10 (Pan) 0-127
43 LSB for Control 11 (Expression Controller) 0-127
44 LSB for Control 12 (Effect control 1) 0-127
45 LSB for Control 13 (Effect control 2) 0-127
46 LSB for Control 14 (Undefined) 0-127
47 LSB for Control 15 (Undefined) 0-127
48 LSB for Control 16 (General Purpose Controller 1) 0-127
49 LSB for Control 17 (General Purpose Controller 2) 0-127
50 LSB for Control 18 (General Purpose Controller 3) 0-127
51 LSB for Control 19 (General Purpose Controller 4) 0-127
52 LSB for Control 20 (Undefined) 0-127
53 LSB for Control 21 (Undefined) 0-127
54 LSB for Control 22 (Undefined) 0-127
55 LSB for Control 23 (Undefined) 0-127
56 LSB for Control 24 (Undefined) 0-127
57 LSB for Control 25 (Undefined) 0-127
58 LSB for Control 26 (Undefined) 0-127
59 LSB for Control 27 (Undefined) 0-127
60 LSB for Control 28 (Undefined) 0-127
61 LSB for Control 29 (Undefined) 0-127
62 LSB for Control 30 (Undefined) 0-127
63 LSB for Control 31 (Undefined) 0-127
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64 Damper Pedal on/off (Sustain)
<63 off, 
>64 on

65 Portamento On/Off
<63 off, 
>64 on

66 Sustenuto On/Off
<63 off, 
>64 on

67 Soft Pedal On/Off
<63 off, 
>64 on

68 Legato Footswitch

<63 
Normal, 
>64 
Legato

69 Hold 2
<63 off, 
>64 on

70 Sound Controller 1 (default: Sound Variation) 0-127
71 Sound Controller 2 (default: Timbre/Harmonic Intens.) 0-127
72 Sound Controller 3 (default: Release Time) 0-127
73 Sound Controller 4 (default: Attack Time) 0-127
74 Sound Controller 5 (default: Brightness) 0-127
75 Sound Controller 6 (default: Decay Time) 0-127
76 Sound Controller 7 (default: Vibrato Rate) 0-127
77 Sound Controller 8 (default: Vibrato Depth) 0-127
78 Sound Controller 9 (default: Vibrato Delay) 0-127
79 Sound Controller 10 (default: undefined) 0-127
80 General Purpose Controller 5 0-127
81 General Purpose Controller 6 0-127
82 General Purpose Controller 7 0-127
83 General Purpose Controller 8 0-127
84 Portamento Control 0-127
85 Undefined ---
86 Undefined ---
87 Undefined ---
88 Undefined ---
89 Undefined ---
90 Undefined ---
91 Effects 1 Depth (default: Reverb Send Level) 0-127
92 Effects 2 Depth 0-127
93 Effects 3 Depth (default: Chorus Send Level) 0-127
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94 Effects 4 Depth 0-127
95 Effects 5 Depth 0-127
96 Data Increment (Data Entry +1) N/A
97 Data Decrement (Data Entry -1) N/A
98 Non-Registered Parameter Number (NRPN) - LSB 0-127
99 Non-Registered Parameter Number (NRPN) - MSB 0-127
100 Registered Parameter Number (RPN) - LSB 0-127
101 Registered Parameter Number (RPN) - MSB 0-127
102 Undefined ---
103 Undefined ---
104 Undefined ---
105 Undefined ---
106 Undefined ---
107 Undefined ---
108 Undefined ---
109 Undefined ---
110 Undefined ---
111 Undefined ---
112 Undefined ---
113 Undefined ---
114 Undefined ---
115 Undefined ---
116 Undefined ---
117 Undefined ---
118 Undefined ---
119 Undefined ---

The Controller numbers 120-127 are reserved for Channel Mode Messages, 
which rather than controlling sound parameters, affect the channel‘s operat-
ing mode.
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